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Introduction
This section describes the features and functions of a Zebra printer that is running the 
Virtual Device-E application. 
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Overview

The Virtual Device-E application enables Zebra Link-OS printers to work with many 
host systems that are using BIXOLON® printers. In most cases, no changes will be 
required to the host application. This feature can help customers to make a smooth 
transition to Zebra printers and save them the time and expense of having to rewrite 
their host software.

Virtual Device-E Features

The Virtual Device-E application:

• Uses existing features of Zebra printers, when available.

• Offers fonts similar to the original device. These fonts will use 120 KB or more of 
memory space.

• Supports the Bluetooth®, Serial, Ethernet, WLAN, and USB interfaces.

• Offers many outline fonts, barcodes, and specific commands and features of 
target printer models (see Supported Fonts on page 137).

• Provides support of BIXOLON commands (see Commands on page 36).
P1067298-003 Virtual Device-E User Guide 08/28/2018



9Introduction
Supported Printers
Supported Printers

This manual describes the Virtual Device-E language for Zebra Link-OS printers and 
should be used by any person who needs to support that language on one of the 
following Zebra printers:

For complete printer operation, use this manual in combination with the User Guide 
for your printer.

Configuring Network Connectivity

Your printer may be equipped with one or more of the following interfaces:

• Bluetooth—For detailed information to connect a Bluetooth device, refer to the 
Bluetooth User Guide.

• Wired print server—For detailed information, refer to the ZebraNet Wired and 
Wireless Print Servers User Guide.

• Wireless print server —For detailed information, refer to the ZebraNet Wired and 
Wireless Print Servers User Guide.

For other connectivity options, refer to the User Guide for your printer. Copies of these 
manuals are available at http://www.zebra.com/manuals.

Printer Firmware

iMZ Series V73.19.6Z and later

QLn Series V68.19.6Z and later

ZT200 Series V72.19.6Z and later

ZT400 Series V75.19.7Z and later

ZT510 V80.20.02Z and later

ZT600 Series V80.20.02Z and later

ZD400 Series V77.19.14Z or V84.20.05Z and later

ZD500 Series V74.19.6Z and later

ZD600 Series V84.20.05Z and later

ZQ300 Series V81.20.06Z and later

ZQ500 Series V76.19.10Z and later

Note • The Virtual Device-E language is supported only on 203 dpi printers.
08/28/2018 Virtual Device-E User Guide P1067298-003
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Notes
• Other command languages are disabled when running Virtual Device-E. 

However, Set/Get/Do (SGD) commands and file download all operate properly 
with Virtual Device-E enabled.

• Virtual Device-E fonts can only be used with Virtual Device-E commands. They 
cannot be used with other languages.

• The Virtual Device-E mode application will not respond to CPCL, ZPL, or EPL 
commands. Instead, commands will be processed by the Virtual Device-E 
application.
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Install, Register, and
Enable Virtual Device-E
This section provides you with instructions on how to install and enable the 
Virtual Device-E application on one or more Zebra printers. 
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Acquiring the Virtual Device Application

To get the Virtual Device app, perform the following from your computer:

1. Open a web browser and navigate to http://www.zebra.com/virtualdevices.

2. Locate your printer type in the list of printers, and then click Download Now.

3. Fill out the information on the Virtual Device Download Request form.

4. Click Submit.

5. Read the End User License Agreement.

6. Click Accept and Begin Download Now.

Your browser prompts you to open or save the archive containing the Virtual 
Device app.

7. Save and store the Virtual Device app archive file to your computer.

The archive file contains the following:

• The Virtual Device .NRD file to be downloaded to a Zebra printer.

• A .txt file that contains the SGD command for immediately activating the 
Virtual Device app.

8. Extract the files from the archive to your computer.
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Downloading the Virtual Device-E Application

Zebra provides two options to download the Virtual Device-E app to the printer.

• On a computer with the ZDownloader Utility

The ZDownloader Utility is the only method shown in this manual. For instructions 
on how to download and install the ZDownloader Utility, see ZDownloader Utility 
on page 140.

• On an Android device with the Zebra Printer Setup Utility for Android Devices 
(available for free on Google Play™)

For information on using the Zebra Printer Setup Utility for Android Devices and to 
download the user guide, navigate to http://www.zebra.com/setup.

Using ZDownloader

The ZDownloader application can update Virtual Device-E files in Zebra printers 
connected by Serial, Parallel, USB, and IP Ethernet networks.

Figure 1 • Initial ZDownloader Screen

Adding Printers to the ZDownloader List

There are two ways to add printers to the list: 

• Auto-Detect (use for USB or IP Ethernet interfaces)

• Manual add (use for Serial, Parallel, or IP Ethernet interfaces)

If your printer is connecting via the serial or parallel interfaces, or is not detected by 
using the Auto-Detect method, use the Manual Add method.
08/28/2018 Virtual Device-E User Guide P1067298-003

www.zebra.com/setup
www.zebra.com/setup
www.zebra.com/setup
www.zebra.com/setup
www.zebra.com/setup


Getting Started
Downloading the Virtual Device-E Application

14
Auto-Detect Printers

Use Auto-Detect for USB or IP Ethernet interfaces. 

USB printers can only be added by using Auto-Detect. The ZDownloader utility can 
support as many USB printers as your computer can support (most computers 
typically can support up to 255).

Note • Ethernet connected printers are detected by the application broadcasting a 
UDP packet out onto the network. UDP port number 4201 is used for the 
discovery process. Some networks filter out UDP packets. This means that the 
ZDownloader utility may not be able to detect all of the printers on your network. 
See your network administrator for more information. If you are not able to Auto-
Detect your network printers, follow instructions for manually adding a printer.
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To Auto-Detect printers connected via the USB or IP Ethernet interfaces, 
perform the following steps:

1. In the ZDownloader toolbar, select Printer > Auto-Detect.

OR

Right-click in the ZDownloader window and select Auto-Detect Printers.

The printers detected are added to the printer list.

Manually Add Printers

To manually add printers connected via the Serial, Parallel, or Network 
interfaces, perform the following steps:

1. In the ZDownloader toolbar, select Printer > Add….

OR

Right-click in the ZDownloader window and select Add Printer…. 

The following window appears.
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2. Add a printer name and your printer model in the appropriate fields.

3. What type of printer are you adding?

Adding a Serial Printer

4. Select the serial port to which the printer is connected.

If you are adding a… Then…

Serial Printer Go to Adding a Serial Printer.

Parallel Printer Go to Adding a Parallel Printer on page 18.

Network Printer Go to Adding a Network Printer on page 19.
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5. Click Port Settings.

The following window appears.

6. Adjust the settings as necessary. The printer’s serial port settings must match the 
computer’s serial port settings. For more information about the settings, refer to 
the User Guide for your printer.

7. Click OK to save the port settings.

8. Click OK to add the printer.
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Adding a Parallel Printer

9. Set Communication Type to Parallel.

The available parallel ports will be shown in the Port drop-down box.

10. Select the port to which the printer is connected. No additional configuration is 
necessary.

11. Click OK to add the printer.
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Adding a Network Printer

12. Set Communication Type to Network. 

The following window appears.

13. Enter the printer’s IP address.

14. Click OK to save the network settings.

15. Click OK to add the printer.

Modifying Printers in the List

To change printer settings for a printer in the list, perform the following steps:

1. Select the printer to modify. 
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2. In the toolbar, select Printer > Modify Printer….

OR

Right-click on the printer and select Modify Printer….

The printer settings for the selected printer are displayed.

3. Modify the settings as desired.

4. Click OK to save the settings.

Deleting Printers from the List

To delete printers from the list, perform the following steps:

1. Select one or more printers to delete. 
P1067298-003 Virtual Device-E User Guide 08/28/2018



21Getting Started
Downloading the Virtual Device-E Application
2. In the toolbar, select Printer > Delete.

OR

Right-click on one of the selected printers and select Delete Printer(s). 

The printer is removed from the list.

Downloading the Virtual Device App to Selected Printers

To download the Virtual Device-E app to your printer(s), you must select the file to 
send to each printer. ZDownloader, by default, downloads files to one printer at a time. 
If you have multiple printers to update and want to speed up the process, you can 
increase the number of simultaneous downloads. 

To allow simultaneous downloads, perform the following step:

1. Click Tools > Options….

The following prompt appears.

2. Raise the number shown to allow multiple simultaneous downloads.

3. Click OK.

Note • More simultaneous downloads require more of your computer resources. 
Some computers may slow down with simultaneous downloads or as more printers 
are added for simultaneous downloading.
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To download the Virtual Device app file to one or more printers, perform the 
following steps:

1. Select the printers to which you want to download the Virtual Device-E app file. To 
select multiple printers, hold down the Ctrl or Shift key, and then click on the 
desired printers.

2. In the toolbar, select File > Select Firmware File….

OR

Right-click on one of the selected printers and select Select Firmware File….

3. Navigate to the Virtual Device app file that you acquired previously.

4. Click Open.

The file that you selected appears under Download File for the selected printers.

Printers that are present in the list but that do not have a file selected will be 
ignored when Downloading starts.
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5. Start the download process by doing one of the following:

• Select Printer > Download to Selected. 

• Select the printer(s) of interest and select the Printer and then select 
Download To Selected.

6. In the toolbar, select Printer > Download All.

OR

Right-click in the ZDownloader window and select Download All.

After downloading has begun, the progress of each printer will be shown in the 
Download Status column.

Canceling a Download in Progress

The Cancel Download toolbar button and the Printer > Cancel Download menu 
options become active when the files are downloading.

To cancel downloading to ALL printers in the list, perform the following step:

1. Click Printer > Cancel Download.

OR

Right-click in the ZDownloader window and select Cancel Download.

To cancel downloading to SPECIFIC printers in the list, perform the following step:

1. Select one or more printers with a download in progress.

2. Click Printer > Cancel Download.

OR

Right-click on a selected printer and select Cancel Download.
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Registering the Virtual Device

ZDownloader maintains a log file of all items downloaded to a Zebra printer along with 
the printer serial number. You can register your Virtual Device installation with Zebra 
Repair and Tech Support to ensure that a printer sent in for repair is returned with the 
Virtual Device installed, and when engaging Zebra Tech Support, they will have 
records of the item being loaded. To register your Virtual Device installation, you must 
send the log file created by ZDownloader to the Zebra log file management group.

ZDownloader Log File

To send the log file, complete these steps:

1. Based on your operating system, navigate to the appropriate folder:

• Microsoft® Windows® XP
C:\Program Files\Common Files\FirmwareDownloader

• Microsoft Windows 7, Windows 8, and Windows 10
C:\ProgramData\Zebra Technologies\Firmware Downloader and 
ZBI Key Manager

2. Copy the log file (DownloadLog.txt), and email to Zdownloader@zebra.com.

If you are downloading from several computers, you need to send the log file from 
each computer. If you download files to printers on one day and do not send the 
file the same day, please note this in your email so that the log file management 
group picks up the previous load detail. Otherwise, they only pick up the load data 
for the day that the log file is sent. 
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Enabling the Virtual Device

You can enable Virtual Device-E by sending a Set/Get/Do (SGD) command to the 
printer or by selecting the option through the printer’s menus.

Using an SGD Command

To enable Virtual Device-E on your printer, send the following command:

! U1 setvar "apl.enable" "apl-e" 

To disable Virtual Devices on your printer and return to normal function, send the 
following command:

! U1 setvar "apl.enable" "none"

You must restart the printer after changing the value of apl.enable. For more 
information about this SGD command, see apl.enable on page 135.

Using the User Menus

This section includes instructions for the following printers:

• QLn420 Printers on page 26

• QLn320 and QLn220 Printers on page 29

• Supported ZTxxx and ZDxxx Printers with a Display on page 32

If necessary, refer to the User Guide for your printer for additional information about 
your printer’s control panel. 
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QLn420 Printers

1. From the printer’s idle display screen, press the LEFT SOFT KEY to select the 
Home icon.

The printer displays the Home Menu.

2. Use the ARROWS to navigate to the LANGUAGE menu.

PRINTER READY

VXXXXXXX

 SETTINGS 

 LANGUAGE 
P1067298-003 Virtual Device-E User Guide 08/28/2018



27Getting Started
Enabling the Virtual Device
3. Press OK.

The printer displays the LANGUAGE selection screen.

4. Use the LEFT or RIGHT ARROW to navigate to the VIRTUAL DEVICE selection 
screen.

LANGUAGE

▼ ENGLISH ▲

VIRTUAL DEVICE

▼ NONE ▲
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5. Use the UP or DOWN ARROW to scroll to the APL-E option.

6. Press the RIGHT SOFT KEY to select USE.

The printer restarts and uses the Virtual Device that you selected.

VIRTUAL DEVICE

▼ APL-E ▲

USE
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QLn320 and QLn220 Printers

1. From the printer’s idle display screen, press the LEFT SOFT KEY to select the 
Home icon.

The printer displays the Home Menu.

2. Use the ARROWS to navigate to the SETTINGS menu.

Zebra QLn320
FW ver: XXXXXXXXXX
Baud Rate: 115200
Battery ok
IP Addr: 10.14.205.138

Menu

Communication Back

Settings Back
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3. Press OK.

The printer displays the VIRTUAL DEVICE selection screen.

4. Press the RIGHT ARROW to highlight the up arrow on the display.

5. With the up arrow highlighted, press the OK button until you scroll to the APL-E 
option.

Virtual Dev: none ▲ ▼

Menu Use Back

Virtual Dev: apl‐e ▲? ▼

Menu Use Back
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6. Press the LEFT ARROW to highlight APL-E

7. Press OK to select USE.

The printer restarts and uses the Virtual Device that you selected.
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Supported ZTxxx and ZDxxx Printers with a Display

1. From the printer’s idle display screen, press the LEFT SELECT KEY to select the 
Home icon.

The printer displays the Home Menu.

Note • The ZT230 control panel is shown in this procedure. The control panel for the 
other printers is similar.

PRINTER READY

VXXXXXXX

HOME MENU

SETTINGS
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2. Use the ARROWS to navigate to the LANGUAGE menu.

3. Press OK.

The printer displays the LANGUAGE selection screen.

HOME MENU

SETTINGS

▼
LANGUAGE

ENGLISH ▲
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4. Use the LEFT or RIGHT ARROW to navigate to the VIRTUAL DEVICE selection 
screen.

5. Use the UP or DOWN ARROW to scroll to the APL-E option.

▼
VIRTUAL DEVICE

NONE ▲

▼
VIRTUAL DEVICE

APL-E ▲

USE
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6. Press the RIGHT SOFT KEY or OK to select USE.

The printer restarts and uses the Virtual Device that you selected.

▼
VIRTUAL DEVICE

APL-E ▲

USE
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Commands
This section provides a detailed listing of commands for use on your Zebra printer 
with the Virtual Device-E app. 
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Command Function

EOT on page 41 Transmit status

HT on page 43 Horizontal tab

LF on page 43 Print and line feed

FF on page 44 Form feed (in Page mode)

CR Print and carriage return

This command has no effect. Use LF on page 43.

DLE Set real-time command mode

Consumed, but not processed.

CAN on page 44 Cancel the print data (in Page mode)

ESC FF on page 44 Print data (in Page mode)

ESC SP on page 45 Set the character right space

ESC ! on page 45 Set print mode

ESC $ on page 46 Set absolute print position

ESC % on page 47 * Enable/disable a user-defined character set

ESC & on page 47 * Define user-defined characters

ESC ? * Cancel the user-defined character

Consumed but not processed.

ESC $ * Delete user-defined characters.

Consumed but not processed.

ESC * on page 48 Specify bit image mode

ESC - on page 49 Turn underline mode on/off

ESC 2 on page 49 Select default line spacing

ESC 3 on page 50 Set line spacing

ESC = Select peripheral device

Consumed but not processed.

ESC @ on page 50 Initialize printer

ESC D on page 51 Set horizontal tab positions

ESC E on page 51 Turn emphasized mode on/off

ESC G on page 52 Turn double-strike mode on/off

ESC J on page 52 Print and feed paper

ESC L on page 53 Select Page mode

ESC M on page 54 Select character font

ESC R on page 55 Specify an international character set

* Support for this command was added after the initial release. To use the command, download 
the latest version of the latest version of the app.
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ESC S on page 56 Select Standard mode

ESC T on page 57 Select print direction (in Page mode)

ESC W on page 58 Set print area (in Page mode)

ESC \ on page 59 Set relative print position

ESC a on page 60 Set position alignment

ESC d on page 60 Print and feed a specified number of lines

ESC t on page 61 Select character code table

ESC { on page 62 Select upside-down printing mode

FS p on page 63 Print the download nonvolatile bit images

FS q on page 64 Define the download nonvolatile bit image

GS ! on page 66 Select character size

GS $ on page 67 Set absolute vertical print position (in Page mode)

GS ( A on page 68 Execute test print

GS ( F on page 69 Set black mark control functions

GS ( k on page 71 Specify and print the symbol

GS ( E on page 97 Set nonvolatile user memory area

GS ( L, GS 8 L on page 108 Select graphics data

GS : on page 116 Start/end macro definition

GS B on page 116 Turn reverse printing mode on/off

GS H on page 117 Select print position of HRI characters

GS I on page 118 Transmit printer ID

GS I b on page 119 Transmit battery status

GS L on page 120 Set left margin

GS T on page 121 Set print position to the beginning of print line

GS W on page 122 Set print area width

GS \ on page 123 Set relative vertical print position (in Page mode)

GS ^ on page 124 Execute macro

GS a Enable/disable Automatic Status Back (ASB)

Consumed, but not processed.

GS f on page 127 Select font for HRI characters

GS h on page 127 Specify barcode height

GS k on page 128 Print barcode

GS r on page 130 Transmit status

GS v 0 on page 131 Print raster bit image

GS w on page 132 Set barcode width

BS L A on page 133 Execute automatic calibration in Label mode

Command Function
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BS L L on page 133 Select Label mode

BS L R on page 134 Select Receipt mode

BS M on page 134 Specify font type

BS M S Define Sentinel characters.

Consumed but not processed.

Command Function
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Command Format

The commands in this section are presented in the following format.

Command

Description  Command Function

Syntax  Command format in ASCII followed by Hexadecimal and decimal equivalents 
(example below for EOT). Variable values are denoted by n (and sometimes other 
letters).

EOTn

Range  The values that can be used for n

Default  Initial value of n (if any)

Notes  In-depth description of the command function

Differences  Variations of the command, status, or results (if any)

ASCII EOT n 

Hex 04 n 

Decimal 4 n 
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EOT

Description  Transmit Status

Syntax  EOTn

Range  1 to 4

Default  none

Notes  Upon request, the printer status is transmitted to the host, which can check the printer 
operating conditions and take appropriate measures.  

Based on the value of n, the printer transmits the following status information.

ASCII EOT n 

Hex 04 n 

Decimal 4 n 

n = 1: Transmit printer status

Bit Binary Hex Decimal Status

0 0 00 0 Not used. Fixed to Off

1 1 02 2 Not used. Fixed to On

2 0 00 0 Not used. Fixed to Off

1 04 4 Not used. Fixed to Off

3 0 00 0 Not used. Fixed to Off

1 08 8 Not used. Fixed to Off

4 1 10 16 Not used. Fixed to On

5 0 00 0 Not used. Fixed to Off

6 0 00 0 Not used. Fixed to Off

7 0 00 0 Not used. Fixed to Off
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n = 2: Transmit offline status

Bit Off/On Hex Decimal Status

0 Off 00 0 Not used. Fixed to Off

1 On 02 2 Fixed to On

2 Off 00 0 Cover is closed

On 04 4 Cover is open

3 Off 00 0 Not used. Fixed to Off

On 08 8 Not used. Fixed to Off

4 On 10 16 Fixed to On

5 Off 00 0 Paper is loaded in the printer.

On 20 32 The printer is out of paper. (Media 
out)

6 Off 00 0 Not used. Fixed to Off

On 40 64 Not used. Fixed to Off

7 Off 00 0 Not used. Fixed to Off

n = 3: Transmit error status

Bit Binary Hex Decimal Status

0 0 00 0 Not used. Fixed to Off

1 1 02 2 Not used. Fixed to On

2 0 00 0 Not used. Fixed to Off

1 04 4 Not used. Fixed to Off

3 0 00 0 Not used. Fixed to Off

1 08 8 Not used. Fixed to Off

4 1 10 16 Not used. Fixed to On

5 0 00 0 Not used. Fixed to Off

1 20 32 Not used. Fixed to Off

6 0 00 0 Not used. Fixed to Off

1 40 64 Not used. Fixed to Off

7 0 00 0 Not used. Fixed to Off
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HT

Description  Horizontal Tab

Syntax  HT

Notes  This command moves the print position to the next horizontal tab position. If a 
horizontal tab position was not set using ESC D on page 51, the printer ignores this 
command.

When in underline mode, the printer does not underline the space created by this 
command.

LF

Description  Print and Line Feed

Syntax  LF

Notes  In Standard mode, this command prints the data in the print buffer and feeds 
one line based on the current set line spacing. In Page mode, the printer does not 
print, but simply moves the print position to the beginning of the next line.

n = 4: Transmit paper sensor status

Bit Binary Hex Decimal Status

0 0 00 0 Not used. Fixed to Off

1 1 02 2 Not used. Fixed to On

2,3 00 00 0 Not used. Fixed to Off

11 0C 12 Not used. Fixed to Off

4 1 10 16 Not used. Fixed to On

5,6 00 00 0 Paper end sensor: paper present

11 60 96 Paper end sensor: paper not present

7 0 00 0 Not used. Fixed to Off

ASCII HT
Hex 09
Decimal 9

ASCII LF
Hex 0A
Decimal 10
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FF

Description  Form Feed (Page mode)

Syntax  FF

Notes  This command works in Page mode, which is enabled by ESC L on page 53. 

When FF is executed, the printer prints all data from the print buffer in Page mode, 
deletes the data, and then returns the print position to the beginning of the next line in 
Standard mode.

Differences  After completion of printing, the printer does not clear the print buffer, 
and the print position moves to the beginning of the line.

CAN

Description  Cancel Print Data (Page mode)

Syntax  CAN

Notes  CAN clears the print buffer.

This command works in Page mode, which is enabled by ESC L on page 53. 

ESC FF

Description  Print Data (Page mode)

Syntax  <ESC>FF

Notes  ESC FF prints the data in the print buffer. After printing, the data in the print 
buffer and the setting values are not cleared, allowing the printer to print the data in 
the print buffer repeatedly using this command.

This command works in Page mode, which is enabled by ESC L on page 53. To 
return the printer to Standard mode, use ESC S on page 56 or ESC @ on page 50.

ASCII FF
Hex 0C
Decimal 12

ASCII CAN
Hex 18
Decimal 24

ASCII ESC FF
Hex 1B 0C
Decimal 27 12
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ESC SP

Description  Set the Character Right Space

Syntax  <ESC>SPn

Range  n = 0 to 255

Default  n = 0

Notes  This command sets the amount of space to the right of a character.

Right space = n × [horizontal motion units].

In a double-width mode, the right space is doubled.

Differences  Horizontal motion unit varies depending on the printhead resolution.

For a 203 dpi printer, horizontal motion unit = 0.125 mm (1/203 inch)

ESC !

Description  Set Print Modes

Syntax  <ESC>!n

Range  n = 0 to 255

Default  n = 0

Notes  As alternatives to this command, the following commands can be used:

• ESC M on page 54 to select character font

• ESC E on page 51 to select emphasized mode

• ESC - on page 49 to select underline mode. When in underline mode, the printer 
does not underline the space created by horizontal tabs.

Based on the value of n, the printer selects print mode(s) as follows.

ASCII ESC SP n 
Hex 1B 20 n 
Decimal 27 32 n 

ASCII ESC ! n 
Hex 1B 21 n 
Decimal 27 33 n 
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Differences  Character configuration (Font A, Font B): Font A (12 × 24), Font B (9 × 
17)

ESC $

Description  Set an Absolute Print Position

Syntax  <ESC>$nLnH

Range  nL = 0 to 255
nH = 0 to 255

Default  None

Notes  This command specifies the next print starting position in reference to the left 
edge of the print area. The printing start position is calculated using:

(nL + nH × 256) × (vertical or horizontal motion units)

• In Standard mode, the horizontal motion unit is used for the calculation.

• In Page mode, the horizontal motion unit is used for the calculation when the print 
start position is defined to the upper right or lower right of print area (using ESC T 
on page 57). Otherwise, the vertical motion unit is used.

The printer ignores any setting values that would cause printing outside of the 
printable area.

Bit Off/On Hex Decimal Function

0 Off 00 0 Character font A selected

On 01 1 Character font B selected

1,2 Off 00 0 Reserved

3 Off 00 0 Emphasized mode not selected

On 08 8 Emphasized mode selected

4 Off 00 0 Double-height mode not selected

On 10 16 Double-height mode selected

5 Off 00 0 Double-width mode not selected

On 20 32 Double-width mode selected

6 Off 00 0 Reserved

7 Off 00 0 Underline mode not selected

On 80 128 Underline mode selected

ASCII ESC $ nL nH
Hex 1B 24 nL nH
Decimal 27 36 nL nH
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Differences  Horizontal and vertical motion units vary depending on the printhead 
resolution. For a 203 dpi printer, horizontal and vertical motion units = 0.125 mm 
(1/203 inch).

ESC %

Description  Enable/disable a user-defined character set

Syntax  <ESC % n

Range  n = 0 to 255

Default  n = 0

Notes  ESC % enables or disables a user-defined character set by assigning the 
Least Significant Bit (LSB) of parameter n. When the user-defined character set is 
disabled, the internal character set is enabled automatically.

• When n = 0, the user-defined character set is disabled

• When n = 1, the user-defined character set is enabled

ESC &

Description  Define user-defined characters

Syntax  <ESC & y c1 c2 [x1 d1...d(y × x1)] ... [xk d1...d(y × 
xk)]

Range  

y = 

32 c1c2126

ASCII ESC % n 

Hex 1B 25 n 

Decimal 27 37 n 

ASCII ESC & y c1 c2 x1 d1...d(y × x1)] ... 
[xk d1...d(y × xk)

Hex 1B 26 y c1 c2 x1 d1...d(y × x1)] ... 
[xk d1...d(y × xk)

Decimal 27 38 y c1 c2 x1 d1...d(y × x1)] ... 
[xk d1...d(y × xk)

3 Font A (12x24)

2 Font B (8x16)
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x = 

d1...d (y × xk) = 0 to 255

k = c2 – c1 + 1

Parameter y defines the number of bytes in the vertical direction while parameter x 
specifies the number of horizontal dots for the font of the user-defined character. 

Parameters c1 and c2 specify the starting and ending code of the characters, 
respectively. If only one character is defined, c1 = c2.

Parameters d1, d2, ... d(y × xk) are the dot data of the metrics of user-defined 
characters.To print a dot, dn = 1.

y × x bytes = the total length of the data of the user-defined characters. The 
maximum for Font A is 36 bytes and for Font B is 16 bytes.

Notes  ESC & creates user-defined characters. This command can define user-
defined characters of the same code for different fonts.

User-defined characters are cleared when the following occur:

• ESC @ is executed

• ESC ? is executed

• The printer is reset or power cycled.

Example  ESC *

Description  Specify Bit Image Mode

Syntax  <ESC>*mnLnH d1...dk

Range  m = 0, 1, 32, 33
nL = 0 to 255
nH = 0 to 3
d = 0 to 255

• d specifies the bit image data with 1 for printed data and 0 for not printed.

• k denotes the number of horizontal dots.

Default  None

Notes  ESC * specifies the bit image for the mode (m) as to the number of dots 
specified by nL and nH.

12 Font A (12x24)

8 Font B (8x16)

ASCII ESC * m nL nH d1...dk
Hex 1B 2A m nL nH d1...dk
Decimal 27 42 m nL nH d1...dk
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ESC -

Description  Turn Underline Mode On/Off

Syntax  <ESC>-n

Range  n = 0, 1, 2, 48, 49, 50

Default  n = 0

Notes  This command enables the text following it to be underlined. Using bit 7 of 
ESC ! on page 45 also activates/deactivates underline mode.

The underline style varies depending on the value of n:

When in underline mode, the printer does not underline the space created by 
horizontal tabs.

ESC 2

Description  Select Default Line Spacing

Syntax  <ESC>2

Notes  This command changes the default line spacing, which can be set for 
Standard mode and Page mode independently of each other. The initial default line 
spacing is 3.75 mm (30 dots).

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII ESC - n
Hex 1B 2D n
Decimal 27 45 n

n Function

0, 48 Turns off underline mode

1, 49 Turns on underline mode, set at 1-dot thick

2, 50 Turns on underline mode, set at 2-dot thick

ASCII ESC 2
Hex 1B 32
Decimal 27 50
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ESC 3

Description  Set Line Spacing

Syntax  <ESC>3n

Range  n = 0 to 255

Default  3.75 mm (30 dots) or the line spacing defined by ESC 2 on page 49

Notes  Line spacing can be set for Standard mode and Page mode independently of 
each other.

ESC @

Description  Initialize Printer

Syntax  <ESC>@

Notes  This command cancels conditions previously set and resets the printer to the 
conditions that existed at power on:

• The data in the print buffer is cleared.

• The data in the receive buffer is not discarded.

• All settings, such as print mode and line feed, are cleared.

• Nonvolatile graphics and nonvolatile user memory are not cleared.

When the printer receives this command in Page mode, the printer removes the data 
in print areas, restores the initial settings, and returns to Standard mode.

ASCII ESC 3 n
Hex 1B 33 n
Decimal 27 51 n

ASCII ESC @
Hex 1B 40
Decimal 27 64
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ESC D

Description  Set Horizontal Tab Position

Syntax  <ESC>DnNUL

Range  n = 1 to 255

Default  n = 8

Notes  This command sets a horizontal tab position at n, which indicates the number 
of columns from the beginning of the line to the tab position. The horizontal tab 
position is stored as a value of [character width × n] measured form the 
beginning of the line.

• The data n signifies the set position and ends with a NUL code. The command 
reads until the NUL code, but only the first value is used for the horizontal tab 
position.

• ESC D NUL cancels all horizontal tab positions.

• Tab position is set at the value of [character width × n] from the beginning of 
the line. The character width includes the space to the right of the character. This 
width is doubled when double width characters are selected.

• The horizontal tab position remains unchanged if the character width changes.

ESC E

Description  Turn Emphasized Mode On/Off

Syntax  <ESC>En

Range  n = 0 to 255

Default  n = 0

Notes  ESC E turns emphasized mode on or off by toggling the least significant bit 
(LSB) of n as follows.

• When the LSB of n is 0, emphasized mode is turned off.

• When the LSB of n is 1, emphasized mode is turned on.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII ESC D n NUL
Hex 1B 44 n 00
Decimal 27 68 n 0

ASCII ESC E n
Hex 1B 45 n
Decimal 27 69 n
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ESC G

Description  Turn Double-Strike Mode On/Off

Syntax  <ESC>Gn

Range  n = 0 to 255

Default  n = 0

Notes  ESC E turns double-strike mode on or off by toggling the least significant bit 
(LSB) of n as follows.

• When the LSB of n is 0, double-strike mode is turned off.

• When the LSB of n is 1, double-strike mode is turned on.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ESC J

Description  Print and Feed Paper

Syntax  <ESC>Jn

Range  n = 0 to 255 dots

Default  None

Notes  ESC J prints the data in the print buffer and feeds the paper by the number of 
dots specified by n.

ASCII ESC G n
Hex 1B 47 n
Decimal 27 71 n

ASCII ESC J n
Hex 1B 4A n
Decimal 27 74 n
P1067298-003 Virtual Device-E User Guide 08/28/2018



53Commands
Virtual Device-E Commands
ESC L

Description  Select Page Mode

Syntax  <ESC>L

Notes  This command switches the printer from Standard mode to Page mode. For 
printing in Page mode, ESC T on page 57 defines the print direction and starting 
position within the print area specified by ESC W on page 58.

The following commands are defined independently in Standard mode and Page 
mode.

• ESC SP on page 45

• ESC 2 on page 49

• ESC 3 on page 50

The following commands are inactive in Page mode.

• ESC L on page 53

• FS q on page 64

• GS ( A on page 68

• GS ( E on page 97

• GS T on page 121

The following commands are ignored in Page mode. Any conditions set by these 
commands in Page mode are available when the printer returns to Standard mode.

• ESC a on page 60

• ESC { on page 62

• GS L on page 120

• GS W on page 122

The printer returns to Standard mode when you use the following commands:

• FF on page 44

• ESC @ on page 50

• ESC S on page 56

In Page mode, the Form Feed command (FF on page 44) prompts printing of data in 
the print buffer. LF on page 43, ESC D on page 51, and ESC J on page 52 move the 
print position without actually printing.

ASCII ESC L
Hex 1B 4C
Decimal 27 76
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ESC M

Description  Select Character Font

Syntax  <ESC>Mn

Range  n = 0, 1, 2, 48, 49, 50, 67, 68, 69, 70, 71, 72, 73

Default  n = 0

Notes  This command selects 1-byte character fonts as defined by n.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

Differences  Configuration of Fonts A, B, and C: Font A (12 × 24), Font B (9 × 17), 
Font C (9 × 24)

ASCII ESC M n
Hex 1B 4D n
Decimal 27 77 n

n Function

0, 48 Character Font A (12 × 24) selected

1, 49 Character Font B (9 × 17) selected

2, 50 Character Font C (9 × 24) selected
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ESC R

Description  Specify International Character Set

Syntax  <ESC>Rn

Range  n = 0 to 10

Default  n = 0

Notes  This command specifies international characters.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII ESC R n
Hex 1B 52 n
Decimal 27 82 n

n Character set n Character set

0 U.S.A. 5 Sweden

1 France 6 Italy

2 Germany 7 Spain I

3 U.K 9 Norway

4 Denmark I 10 Denmark II
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ESC S

Description  Select Standard Mode

Syntax  <ESC>S

Notes  This command enables Standard mode.

The data in the print buffer is cleared, and any changes made by ESC W on page 58 
return to the default.

The following commands are defined independently in Standard mode and Page 
mode.

• ESC SP on page 45

• ESC 2 on page 49

• ESC 3 on page 50

The following commands are ignored in Standard mode.

• CAN on page 44

• ESC FF on page 44

• GS $ on page 67

• GS \ on page 123

ASCII ESC S
Hex 1B 53
Decimal 27 83
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ESC T

Description  Select Print Direction (Page mode)

Syntax  <ESC>Tn

Range  n = 0 to 3, 48 to 51

Default  n = 0

Notes  In Page mode, ESC T specifies the print direction and the starting print 
position. In Standard mode, ESC T specifies the print direction but does not effect the 
starting print position. If the command is processed in Standard mode, any changes 
take effect when the printer changes to Page mode.

The starting print position set by this command determines whether the horizontal 
motion unit or vertical motion unit is used for some commands.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII ESC T n
Hex 1B 54 n
Decimal 27 84 n

n Print Direction Starting Print Position

0, 48 Left right Upper left

1,49 Bottom to top Lower left

2, 50 Right left Lower right

3, 51 Top bottom Upper right

When the starting print 
position is the...

 Horizontal motion unit 
is used for:

Vertical motion unit is 
used for:

upper left or lower right of 
the print area

• ESC SP on page 45
• ESC $ on page 46
• ESC \ on page 59

• ESC 3 on page 50
• ESC J on page 52
• GS $ on page 67
• GS \ on page 123

upper right or lower left of 
the print area

• ESC 3 on page 50
• ESC J on page 52
• GS $ on page 67
• GS \ on page 123

• ESC SP on page 45
• ESC $ on page 46
• ESC \ on page 59
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ESC W

Description  Set Print Area (Page mode)

Syntax  <ESC>W xL xH yL yH dxL dxH dyL dyH

Range  
0 ? (xL + xH × 256) ? 65535 (0 ? xL ? 255, 0 ? xH ? 255)
0 ? (yL + yH × 256) ? 65535 (0 ? yL ? 255, 0 ? yH ? 255)
1 ? (dxL + dxH × 256) ? 65535 (0 ? dxL ? 255, 0 ? dxH ? 255)
1 ? (dyL + dyH × 256) ? 65535 (0 ? dyL ? 255, 0 ? dyH ? 255)

Default  When paper width of 48mm is selected: 
(xL + xH × 256) = 0 (xL = 0, xH = 0)
(yL + yH × 256) = 0 (yL = 0, yH = 0)
(dxL + dxH × 256) = 384 (dxL = 80, dxH = 1) 
(dyL + dyH × 256) = 2400 (dyL = 60, dyH = 9)

Notes  ESC W sets the position and the size of the printing area in Page mode as 
follows.

• Horizontal starting position = [(xL + xH × 256) × (horizontal motion units)]

• Vertical starting position = [(yL + yH × 256) × (vertical motion units)]

• Horizontal printing area width = [(dxL + dxH × 256) × (horizontal motion units)]

• Vertical printing area width = [(dyL + dyH × 256) × (vertical motion units)]

ASCII ESC W xL xH yL yH dxL dxH dyL dyH
Hex 1B 57 xL xH yL yH dxL dxH dyL dyH
Decimal 27 87 xL xH yL yH dxL dxH dyL dyH

If the following condition 
exists...

Then...

The horizontal and vertical 
starting positions are out of the 
printable area

The ESC W command is ignored, and any 
data that follows is processed normally.

(Horizontal starting position + 
Horizontal printing area width) is 
outside of the printable area

The Horizontal printing area width is set to 
(Horizontal printing area - Horizontal starting 
position).

(Vertical starting position + 
Vertical printing area width) is 
outside of the printable area

The Vertical printing area width is set to 
(Vertical printing area - Vertical starting 
position).
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In Standard mode, ESC W is ignored. If the command is processed in Standard mode, 
any changes take effect when the printer changes to Page mode.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

Differences  The maximum printable area varies by printer model.

ESC \

Description  Set Relative Print Position

Syntax  <ESC>\nLnH

Range  nL = 0 to 255, nH = 0 to 255
0 ? (nL + nH × 256) ? 65535

Default  None

Notes  This command sets the print starting position based on the current position to 
[(nL + nH × 256) × horizontal or vertical motion unit]

The print starting position is moved to (nL + nH × 256) in the right direction based on 
the current position. The printer ignores this command when any setting exceeds the 
print area.

• In Standard mode, the vertical motion unit is used for the calculation.

• In Page mode, the horizontal motion unit is used for the calculation when the print 
start position is defined to the upper right or lower right of print area (using ESC T 
on page 57). Otherwise, the vertical motion unit is used.

When in underline mode, the printer does not underline the space created by this 
command.

ASCII ESC \ nL nH

Hex 1B 5C nL nH
Decimal 27 92 nL nH
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ESC a

Description  Set Position Alignment

Syntax  <ESC>an

Range  n = 0 to 2, 48 to 50

Default  n = 0

Notes  In Standard mode, ESC a specifies position alignment for all data in one line. 
In Page mode, ESC a is ignored. If the command is processed in Page mode, any 
changes take effect when the printer changes to Standard mode.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ESC d

Description  Print and Feed a Specified Number of Lines

Syntax  <ESC>dn

Range  n = 0 to 255

Default  None

Notes  This command feeds the paper by n lines after printing the data in the print 
buffer. In Page mode, the printer does not print, but simply moves the print position 
the specified number of lines. The amount fed for each line is based on the values set 
by the line spacing commands (ESC 2 on page 49 and ESC 3 on page 50).

If the feed amount is set to a value greater than the maximum feed value of 255 lines, 
the printer defaults to 255.

ASCII ESC a n
Hex 1B 61 n
Decimal 27 97 n

n Alignment

0, 48 Left alignment

1, 49 Center alignment

2, 50 Right alignment

ASCII ESC d n
Hex 1B 64 n
Decimal 27 100 n
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ESC t

Description  Select a Character Code Table

Syntax  <ESC>tn

Range  n = one of the following values:

For additional code page support, contact Zebra Technologies.

Default  n = 0

Notes  This command assigns the code page specified by n.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII ESC t n
Hex 1B 74 n
Decimal 27 116 n

n Code page

0 Page 0 437 (USA, Standard Europe)

2 Page 2 850 (Multilingual)

16 Page 16 1252 (Latin 1)

28 Page 28 1251 (Cyrillic)
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ESC {

Description  Set Upside-Down Printing Mode

Syntax  <ESC>{n

Range  n = 0 to 255

Default  n = 0

Notes  In Standard mode, this command specifies upside-down printing mode 
according to the least significant bit (LSB). This command is valid only when entered 
at the beginning of the line.

In Page mode, ESC {is ignored. If the command is processed in Page mode, any 
changes take effect when the printer changes to Standard mode.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII ESC { n
Hex 1B 7B n
Decimal 27 123 n

LSB Upside-down mode

0 Turned off
(characters print right-side-up 
from left to right)

Example of non-rotated text

1 Turned on
(characters print upside-down 
from right to left) Example of rotated text
P1067298-003 Virtual Device-E User Guide 08/28/2018



63Commands
Virtual Device-E Commands
FS p

Description  Print Nonvolatile Bit Images

Syntax  FSpnm

Range  n = 1 to 255
m = 0 to 3, 48 to 51

Default  None

Notes  This command prints the nonvolatile bit images (n) using the mode specified 
by m. The download nonvolatile bit image refers to the image that was defined by FS q 
on page 64 in the nonvolatile memory. If the image is not defined, this command is 
invalid.

In Standard mode, this command is valid only when the print buffer is empty. In Page 
mode, this command is invalid. Printing modes other than upside-down printing are 
unaffected by this command.

When the print area set by the functions GS L on page 120 and GS W on page 122 is 
not enough for one vertical line of the download NV bit image, the line is dealt with as 
follows. One vertical line of the bit image is one dot in normal mode (m = 0, 48) and 
double height mode (m = 2, 50). It is two dots in double width mode (m = 1, 49) and 
quadruple size mode (m = 3, 51).

1. The printing area is extended to the right side within the limits of the printing area 
so that one vertical line of the download NV bit image can be printed.

2. When a sufficient printing area cannot be maintained even after executing number 
1, the printing area is extended to the left side. (The left margin is reduced.)

When the size of a bit image exceeds the limits of the print area, the printer prints the 
data inside the limits of the print area, but not the parts exceeding the limit. When bit 
image printing is complete, the head of the line is used for the next printing position, 
and normal data processing takes place.

ASCII FS p n m

Hex 1C 70 n m
Decimal 28 112 n m

m Mode Vertical dot density (DPI)
Horizontal dot density 
(DPI)

0, 48 Normal 203 203

1, 49 Double-width 203 203/2

2, 50 Double-height 203/2 203

3, 51 Quadruple 203/2 203/2
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No matter what line feed distance is set with ESC 2 on page 49 and ESC 3 
on page 50, normal mode and double width mode execute a paper feed equal to the 
height n of the nonvolatile bit image (in dots) while double height mode and quadruple 
size mode execute a paper feed equal to the height n of the nonvolatile bit image × 2 
(in dots).

FS q

Description  Define Nonvolatile Bit Images

Syntax  FSqn[xL xH yL yH d1...dk]1 ... [xL xH yL yH d1...dk]n

Range  n = 1 to 255 = the number of bit images to be defined
xL = 0 to 255
xH = 0 to 3, 1 ? (xL + xH × 256) ? 1023
yL = 0 to 255
yH = 0 to 1, 1 ? (yL + yH × 256) ? 288
d = 0 to 255 = the definition data. Bits that correspond to dots that are to be 
printed are designated as “1”, and those not to be printed as “0.”
k = (xL + xH × 256) × (yL + yH × 256) × 8
Total definition area = 2 Megabits (256 Kbytes)
xL, xH define the horizontal size of a bit image as (xL + xH × 256) × 8
yL, yH define the vertical size of a bit image as (yL + yH × 256) × 8

Default  n = 0

Notes  This command defines the specified nonvolatile bit image. A nonvolatile bit 
image refers to a bit image that is defined by this command in the nonvolatile memory 
and printed by FS p on page 63. Existing nonvolatile bit images are not erased by the 
ESC @ command or when the printer is reset or power cycled.

This command deletes all of the nonvolatile bit images previously defined and stored 
by this command, meaning that it is not possible to retain any of the previously 
defined images. All of the data must be resent.

In Standard mode, this command is valid only when it is written at the head of a line. 
In Page mode, this command is invalid.

This command becomes valid after the 7 bytes of <FS q n xL xH yL yH> are 
processed as normal values.

ASCII FS q n [xL xH yL yH 
d1...dk]1

[xL xH yL yH 
d1...dk]n

Hex 1C 71 n [xL xH yL yH 
d1...dk]1

[xL xH yL yH 
d1...dk]n

Decimal 29 33 n [xL xH yL yH 
d1...dk]1

[xL xH yL yH 
d1...dk]n
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When data that exceeds the remaining capacity of the defined area is specified by xL, 
xH, yL, yH, outside-defined-area arguments are processed. When outside-defined-
area arguments are processed for the first bit image data group, this command 
becomes invalid. If outside-defined-area arguments are processed for the second or 
subsequent nonvolatile bit image data groups, the printer stops processing this 
command and begins writing into the nonvolatile memory. At this time, the nonvolatile 
bit image being defined becomes invalid (undefined), but the preceding nonvolatile bit 
images remain valid.

The first data group, which is defined by [xL xH yL yH d1…dk], becomes nonvolatile 
bit image number 01H, and the last data group becomes nonvolatile bit image number 
0nH. The number n of nonvolatile bit images coincides with those specified by FS p 
on page 63. If only one nonvolatile bit image is defined (n = 1), the data group is 
manipulated once, and the following determines the number of bytes of non-volatile 
memory used to store it.

[Bit image data: ((xL + xH × 256) × (yL + yH × 256) × 8) + Header: (4 bytes)]

The maximum bit image size for this printer is 2 Mbits (256 Kbytes). Multiple 
nonvolatile bit images can be defined, but the total size of a bit image (Bit image data 
+ Header) may not exceed 2 Mbits (256 Kbytes).

This example shows the bit image area defined when xL = 64, xH = 0, yL = 96, and yH 
= 0:
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GS !

Description  Specify Character Size

Syntax  GS!n

Range  n = 0 to 255
(Vertical enlargement = 1 to 8, Horizontal enlargement = 1 to 8)

Default  n = 0

Notes  This command specifies the character height and width using bits 0 to 7 as 
follows:

ASCII GS ! n
Hex 1D 21 n
Decimal 29 33 n

Bit Function Setting

0 Specifies the number of times to 
enlarge the font size vertically1

2

3

4 Specifies the number of times to 
enlarge the font size horizontally5

6

7

Hex Decimal Enlargement

00 0 1 time (standard)

01 1 2 times

02 2 3 times

03 3 4 times

04 4 5 times

05 5 6 times

06 6 7 times

07 7 8 times

Hex Decimal Enlargement

00 0 1 time (standard)

10 16 2 times

20 32 3 times

30 48 4 times

40 64 5 times

50 80 6 times

60 96 7 times

70 112 8 times
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The character size set by this command is valid for alphanumeric characters, user-
defined characters, and multi-byte code characters (such as Chinese, Japanese, and 
Korean). Double-width and double-height modes can also be set by ESC ! 
on page 45. 

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

GS $

Description  Set Absolute Vertical Print Position ( Page Mode)

Syntax  GS$nLnH

Range  nL = 0 to 255, nH = 0 to 255
0 ? (nL + nH × 256) ? 65535 

Default  None

Notes  GS $ is ignored in Standard mode.In Page mode, GS $ sets the absolute 
vertical print starting position to 

[(nL + nH × 256) × (vertical or horizontal motion unit)]

Depending on the print direction set by ESC T on page 57, the vertical motion unit is 
used for the calculation when the print start position is defined as the upper left or 
lower right of the print area (using ESC T on page 57). Otherwise, the horizontal 
motion unit is used.

The printer ignores any setting values that would cause printing outside of the print 
area set by ESC W on page 58.

ASCII GS $ nL nH
Hex 1D 24 nL nH
Decimal 29 36 nL nH
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GS ( A

Description  Execute Test Print

Syntax  GS(ApLpHnm

Range  n = 0 to 2, 48 to 50
m = 1 to 3, 49 to 51
(pL + pH × 256) = 2 (pL = 2, pH = 0)

Default  None

Notes  This command prints a specified pattern for testing on a roll paper.

• Roll paper is specified by n.

• The type of test print is specified by m.

After completion of this command, a software reset is executed automatically to 
restore the printer status set during power cycling. If this command is processed while 
a macro definition is in progress, the printer cancels the macro definition, and the 
macro becomes invalid. 

The real-time command and ASB operations are not executed during the printing of 
printer configuration (m = 2, 50) and rolling pattern (m = 3, 51).

ASCII GS ( A pL pH n m
Hex 1D 28 41 pL pH n m
Decimal 29 40 65 pL pH n m

n Paper type

0, 48

1, 49

2, 50

Roll paper

m Test print

1, 49 Hexadecimal dump mode (The printer prints all of 
the data transmitted from the host to the printer.)

2, 50 Printer configuration printing

3, 51 Rolling pattern printing
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GS ( F

Description  Set Black Mark Control Functions

Notes  This command performs various functions to control the black mark media 
when the black mark sensor is used. The command is stored and processed in the 
order it was received, so you may notice a delay in execution of this command.

pL, pH specifies (pL + (pH × 256)) as the number of bytes after pH (m and other 
parameters).

<Function 2> (m = 2) — GS ( F pL pH m a nL nH

Description  Adjust Black Mark Paper Position

Syntax  GS ( F pL pH m a nL nH

Range  (pL + pH × 256) = 4 (pL = 4, pH = 0)
m = 2
a = 0, 48
0 ? (nL + nH × 256) ? 65535 (nL = 0 to 255, nH = 0 to 255)

Default  nL = 0, nH = 0

Notes  This command adjusts the paper position after the printer senses a black 
mark.

• pL, pH specifies (pL + pH × 256) as the number of bytes after pH (m, a, nL, and nH)

• nL, nH specifies [(nL + nH × 256) × vertical motion units] as the adjustment value.

This command applies only toward forward paper feeding. 

If the adjustment value specified is greater than the maximum adjustable length of 
400 mm, the printer defaults to 400 mm.

m Format Function

2 GS ( F pL pH m a nL nH Sets the paper feed amount to adjust the paper 
cutting position after sensing the black mark.

112 GS ( F pL pH m aL aH bL bH Specifies the black mark paper format.

ASCII GS ( F pL pH m a nL nH

Hex 1D 28 46 04 00 02 a nL nH

Decimal 29 40 70 4 0 2 a nL nH
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<Function 112> (m = 112) — GS ( F pL pH m aL aH bL bH

Description  Set Black Mark Paper Format

Syntax  GS ( F pL pH m aL aH bL bH

Range  (pL + pH × 256) = 5 (pL = 5, pH = 0)
m = 112
0 ? (aL + aH × 256) ? 65535 (aL = 0 to 255, aH = 0 to 255)
0 ? (bL + bH × 256) ? 65535 (bL 0 to 255, bH = 0 to 255)

Default  aL = 141, aH = 0 (black mark height (from the top of a mark to the bottom): 20 
mm)

bL = 20, bH = 11 (black mark interval (top of a black mark to the top of the next 
one): 400 mm)

Notes  This command sets the black mark paper format.

• pL, pH specifies (pL + pH × 256) as the number of bytes after pH (m, aL, aH, bL, bH).

• aL, aH specifies [(aL + aH × 256) × vertical motion units] as the black mark height.

• bL, bH specifies as [(bL + bH × 256) × vertical motion units] as the black mark 
interval.

The available black mark height ranges from 4 to 20 mm. If the black mark height 
specified is out of range, this command is ignored.

The black mark interval ranges from 40 to 400 mm. If the black mark interval specified 
is out of range, this command is ignored.

ASCII GS ( F pL pH m aL aH bL bH
Hex 1D 28 46 05 00 70 aL aH bL bH
Decimal 29 40 70 5 0 112 aL aH bL bH
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GS ( k

Description  Specify and Print Symbols

Notes  This command specifies data for two-dimensional codes.

• cn = symbol type

• fn = function code

cn Two-Dimensional Code

48 PDF417

49 QR CODE

50 MAXI CODE

51 DATA MATRIX

cn fn Function

48 65 <Function 065> (fn = 65) 
on page 74

PDF417: Specify the number of columns

66 <Function 066> (fn = 66) 
on page 75

PDF417: Specify the number of rows

67 <Function 067> (fn = 67) 
on page 76

PDF417: Specify the width of module

68 <Function 068> (fn = 68) 
on page 76

PDF417: Specify the module height

69 <Function 069> (fn = 69) 
on page 77

PDF417: Specify the error correction 
level

70 <Function 070> (fn = 70) 
on page 78

PDF417: Specify the option

80 <Function 080> (fn = 80) 
on page 79

PDF417: Store the received data in the 
symbol storage area

81 <Function 081> (fn = 81) 
on page 80

PDF417: Print the symbol data in the 
symbol storage area

82 <Function 082> (fn = 82) 
on page 82

PDF417: Send the size information of the 
symbol data in the symbol storage area
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PDF417 Symbol Data (when cn = 48)

The symbol data is defined, stored to the symbol storage area by <Function 080> (fn 
= 80) on page 79 and printed by the specification of <Function 081> (fn = 81) 
on page 80. The symbol data in the area remains reserved until one the following 
processes is executed:

• Performing <Function 080> (fn = 80) on page 79

• Performing ESC @ on page 50

• Resetting the printer defaults or power cycling the printer

The setting values of Functions 065 to 070 are utilized for the processing of <Function 
080> (fn = 80) on page 79 or <Function 082> (fn = 82) on page 82. The printable area 
must be large enough to accommodate different-sized symbols. If not, the symbol 
may not be printed.

• Print the same symbol data repeatedly by executing <Function 081> (fn = 81) 
on page 80 after performing Function 080.

49 65 <Function 165> (fn = 65) 
on page 83

QR CODE: Select the module

67 <Function 167> (fn = 67) 
on page 84

QR CODE: Select the size of module

69 <Function 169> (fn = 69) 
on page 85

QR CODE: Select the error correction 
level

80 <Function 180> (fn = 80) 
on page 86

QR CODE: Store the data in the symbol 
storage area

81 <Function 181> (fn = 81) 
on page 87

QR CODE: Print the data in the symbol 
storage area

82 <Function 182> (fn = 82) 
on page 89

QR CODE: Transmit the size information 
of the symbol data in the symbol storage 
area

50 65 <Function 265> (fn = 65) 
on page 90

MAXI CODE: Select the mode

80 <Function 280> (fn = 80) 
on page 91

MAXI CODE: Store the data in the 
symbol storage area

81 <Function 281> (fn = 81) 
on page 92

MAXI CODE: Print the symbol data 
saved in the symbol storage area

51 67 <Function 367> (fn = 67) 
on page 94

DATA MATRIX: Select the size of module

80 <Function 380> (fn = 80) 
on page 95

DATA MATRIX: Store the symbol data in 
the

symbol storage area

81 <Function 381> (fn = 81) 
on page 96

DATA MATRIX: Print the symbol data in 
the storage area
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• The same symbol data is printed differently by executing <Function 081> (fn = 81) 
on page 80 after setting the feature of the symbol by using Functions 065 through 
070.

• By using <Function 082> (fn = 82) on page 82, the symbol size printed by 
<Function 081> (fn = 81) on page 80 is Available.

QR Code® Symbol Data (cn = 49)

The symbol data is defined, stored to the symbol storage area by <Function 180> (fn 
= 80) on page 86 and printed by the specification of <Function 181> (fn = 81) 
on page 87. The symbol data in the area remains reserved until one the following 
processes is executed:

• Performing Function 180

• Performing ESC @ on page 50

• Resetting the printer defaults or power cycling the printer

The setting values of Functions 165 to 169 are utilized for the processing of <Function 
180> (fn = 80) on page 86 or <Function 182> (fn = 82) on page 89. The printable area 
must be large enough to accommodate different-sized symbols. If not, the symbol 
may not be printed.

Print the symbol data repeatedly by executing <Function 181> (fn = 81) on page 87 
after performing <Function 180> (fn = 80) on page 86.

The same symbol data is printed differently by executing <Function 181> (fn = 81) 
on page 87 after setting the feature of the symbol by using Functions 165 through 
169.

By using <Function 182> (fn = 82) on page 89, the symbol size printed by <Function 
181> (fn = 81) on page 87 is available.

MaxiCode Symbol Data (cn = 50)

The symbol data is defined, stored to the symbol storage area by <Function 280> (fn 
= 80) on page 91 and printed by the specification of <Function 281> (fn = 81) 
on page 92. The symbol data in the area remains reserved until one the following 
processes is executed:

• Performing <Function 280> (fn = 80) on page 91

• Performing ESC @ on page 50

• Resetting the printer defaults or power cycling the printer

The setting value of <Function 265> (fn = 65) on page 90 is utilized for the processing 
of <Function 281> (fn = 81) on page 92. The printable area must be large enough to 
accommodate different-sized symbols. If not, the symbol may not be printed.

The same symbol data is repeatedly printed by executing <Function 281> (fn = 81) 
on page 92 after performing <Function 280> (fn = 80) on page 91.

The same symbol data is printed differently by executing <Function 281> (fn = 81) 
on page 92 after setting the mode by using <Function 265> (fn = 65) on page 90.
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Data Matrix Symbol Data (cn = 51)

The symbol data is defined, stored to the symbol storage area by <Function 380> (fn 
= 80) on page 95 and printed by the specification of <Function 381> (fn = 81) 
on page 96. The symbol data in the area remains reserved until the following 
processes are executed:

• Performing <Function 380> (fn = 80) on page 95

• Performing ESC @ on page 50

• Resetting the printer defaults or power cycling the printer

The setting value of <Function 367> (fn = 67) on page 94 is utilized for the processing 
of <Function 381> (fn = 81) on page 96. The printable area must be large enough to 
accommodate different-size symbols. If not, the symbol may not be printed.

The same symbol data is repeatedly printed by executing <Function 381> (fn = 81) 
on page 96 after performing <Function 380> (fn = 80) on page 95.

The same symbol data is printed differently by executing <Function 381> (fn = 81) 
on page 96 after setting the mode by using <Function 367> (fn = 67) on page 94.

<Function 065> (fn = 65) — GS ( k pL pH cn fn n

Description  Specify Number of Columns for PDF417

Syntax  GS ( k pL pH cn fn n

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)

cn = 48, fn = 65

n = 0 to 30

Default  n = 0

Notes  This command specifies the number of columns in the data area of PDF417.

• When n = 0, automatic processing is set.

• When n does not equal 0, the number of columns of the data area is set to n.

The settings of this function affect the processing of <Function 081> (fn = 81) 
on page 80 and <Function 082> (fn = 82) on page 82.

The following data is excluded from the number of columns:

• Start and stop patterns

• Indicator code word of left and right

ASCII GS ( k pL pH cn fn n
Hex 1D 28 6B 03 00 30 41 n
Decimal 29 40 107 3 0 48 65 n
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With auto processing (n = 0) specified, the maximum number of columns in the data 
area is set to 30 columns. The actual number of columns is calculated using the 
following information:

• Print area when processing <Function 081> (fn = 81) on page 80 or <Function 
082> (fn = 82) on page 82

• Module width (<Function 067> (fn = 67) on page 76)

• Option setting (<Function 070> (fn = 70) on page 78)

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

<Function 066> (fn = 66) — GS ( k pL pH cn fn n

Description  Specify Number of Rows for PDF417

Syntax  GS ( k pL pH cn fn n

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 48
fn = 66
n = 0, 3 to 90

Default  n = 0

Notes  This command specifies the number of rows in the data area of PDF417.

• When n = 0, automatic processing is set

• When n does not equal 0, the number of rows is set to n rows.

The settings of this function affect the processing of <Function 081> (fn = 81) 
on page 80 and <Function 082> (fn = 82) on page 82.

With auto processing (n = 0) specified, the maximum number of rows is set to 90. The 
actual number of rows is calculated by using the following information:

• Print area when processing <Function 081> (fn = 81) on page 80 or <Function 
082> (fn = 82) on page 82

• Module height (<Function 068> (fn = 68) on page 76)

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS ( k pL pH cn fn n
Hex 1D 28 6B 03 00 30 42 n
Decimal 29 40 107 3 0 48 66 n
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<Function 067> (fn = 67) — GS ( k pL pH cn fn n

Description  Specify Width of Module for PDF417

Syntax  GS ( k pL pH cn fn n

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 48
fn = 67
n = 2, 3

Default  n = 3

Notes  This command sets the width of the module of the PDF417 symbol to n dots.

The settings of this function affect the processing of <Function 081> (fn = 81) 
on page 80 and <Function 082> (fn = 82) on page 82.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

<Function 068> (fn = 68) — GS ( k pL pH cn fn n

Description  Specify Module Height for PDF417

Syntax  GS ( k pL pH cn fn n

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 48
fn = 68
n = 2 to 8

Default  n = 3

Notes  This command sets the module height of PDF417 to [the module width × n]

The settings of this function affect the processing of <Function 081> (fn = 81) 
on page 80 and <Function 082> (fn = 82) on page 82.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS ( k pL pH cn fn n
Hex 1D 28 6B 03 00 30 43 n
Decimal 29 40 107 3 0 48 67 n

ASCII GS ( k pL pH cn fn n
Hex 1D 28 6B 03 00 30 44 n
Decimal 29 40 107 3 0 48 68 n
P1067298-003 Virtual Device-E User Guide 08/28/2018



77Commands
Virtual Device-E Commands
<Function 069> (fn = 69) — GS ( k pL pH cn fn m n

Description  Specify Error Correction Level for PDF417

Syntax  GS ( k pL pH cn fn m n

Range  (pL + pH × 256) = 4 (pL = 4, pH = 0)

cn = 48 fn = 69 m = 48

n = 0 to 8, 48 to 56

Default  None

Notes  This command specifies the error correction level for PDF417. The settings of 
this function affect the processing of <Function 081> (fn = 81) on page 80 and 
<Function 082> (fn = 82) on page 82.

Error correction level specified by “level” (m = 48) is as follows:

• The number of the error correction codeword is unchanged regardless of the 
number of codeword in the data area.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS ( k pL pH cn fn m n
Hex 1D 28 6B 04 00 30 45 m n
Decimal 29 40 107 4 0 48 69 m n

n Function
Number of error correction 
codeword

48 Error correction level 0 2

49 Error correction level 1 4

50 Error correction level 2 8

51 Error correction level 3 16

52 Error correction level 4 32

53 Error correction level 5 64

54 Error correction level 6 128

55 Error correction level 7 256

56 Error correction level 8 512
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<Function 070> (fn = 70) — GS ( k pL pH cn fn m

Description  Select the PDF417 Option

Syntax  GS ( k pL pH cn fn m

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 48
fn = 70
m = 0, 1

Default  m = 0

Notes  This command selects the option for PDF417.

The settings of this function affect the processing of <Function 081> (fn = 81) 
on page 80 and <Function 082> (fn = 82) on page 82.

When simplified PDF417 symbol is canceled, the printer defaults to standard 
PDF417.

This command remains in effect until one of the following occurs: ESC ! on page 45 or 
ESC @ on page 50 is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS ( k pL pH cn fn m
Hex 1D 28 6B 03 00 30 46 m
Decimal 29 40 107 3 0 48 70 m

m Function

0 Select the standard PDF417

1 Select the simplified PDF417
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<Function 080> (fn = 80) — GS ( k pL pH cn fn m d1...dk

Description  Store PDF417 Symbol Data

Syntax  GS ( k pL pH cn fn m d1...dk

Range  4 ? (pL + pH × 256) ? 65535 (pL = 0 to 255, pH = 0 to 255)
cn = 48 
fn = 80 
m = 48
d = 0 to 255
k = (pL + pH × 256) – 3

Default  None

Notes  This command stores the PDF417 symbol data (d1...dk) in the symbol 
storage area.

The data stored in the symbol storage area by this command remains reserved after 
processing <Function 081> (fn = 81) on page 80 or <Function 082> (fn = 82) 
on page 82.

The following data should not be included in the symbol data (d1...dk) because this 
information is automatically added by the printer:

• Start pattern and stop pattern.

• Indicator codeword of left and right.

• The descriptor of symbol length. (the first code word in the data area)

• The error correction codeword calculated by modulus 929.

This command remains in effect until the following processing is performed:

• Executing <Function 080> (fn = 80) on page 79

• Executing ESC @ on page 50

• The printer defaults are reset, or the printer is power cycled

ASCII GS ( k pL pH cn fn m d1...dk
Hex 1D 28 6B pL pH 30 50 30 d1...dk
Decimal 29 40 107 pL pH 48 80 48 d1...dk
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<Function 081> (fn = 81) — GS ( k pL pH cn fn m

Description  Encode and Print PDF417 Symbol Data

Syntax  GS ( k pL pH cn fn m

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 48 
fn = 81 
m = 48

Default  None

Notes  This function encodes and prints the PDF417 symbol data in the symbol save 
area.

In Standard mode, this command is available only when the printer is at the beginning 
of a line or when the print buffer is empty. The paper feed amount set by the paper 
feed setting command does not affect printing of the symbol. The printing position 
returns to the left side of the printable area after printing the symbol. In Page mode, 
the printer stores the symbol data in the print buffer without printing.

The printer cannot print a symbol that exceeds the printing area in size. Print modes 
(such as emphasized or double-strike) do not affect the printing of a symbol. 
Exceptions are the character size and upside-down printing.

Printing operation is not processed under the following conditions:

• There is no data (<Function 080> (fn = 80) on page 79 is not processed).

• The (number of columns × number of rows) is less than the number of codewords 
when automatic processing is specified for the number of columns and number of 
rows.

• More than 928 codewords exist in the data area.

The following data is added automatically by the encode processing:

• Start pattern and stop pattern.

• Indicator codeword of left or right.

• The descriptor of symbol length (the first codeword in the data area).

• The error correction codeword that was calculated by modulus 929.

• A pad codeword.

ASCII GS ( k pL pH cn fn m
Hex 1D 28 6B 03 00 30 51 m
Decimal 29 40 107 3 0 48 81 m
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The data area includes the following codewords:

• Data specified by <Function 080> (fn = 80) on page 79.

• The descriptor of symbol length (the first codeword in the data area).

• The error correction codeword that was calculated by modulus 929.

• A pad codeword.

When automatic processing (<Function 065> (fn = 65) on page 74) is specified, the 
printer calculates the number of columns (maximum of 30) using the following 
information:

• The current printing area

• The module width (<Function 067> (fn = 67) on page 76)

• The option setting (<Function 070> (fn = 70) on page 78)

• The codeword in the data area

When automatic processing (<Function 066> (fn = 66) on page 75) is specified in 
Page mode, the printer calculates the number of rows (maximum of 90) using the 
following information:

• Current printing area

• Module height (<Function 068> (fn = 68) on page 76)

• Codeword in the data area

A quiet zone (the spaces surrounding the symbol such as upper, lower, left, and right 
spaces) is not included in the printing data. Make sure to include an adequate quiet 
zone for execution of this command.
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<Function 082> (fn = 82) — GS ( k pL pH cn fn m

Description  Encode and Send Size Information for PDF417 Symbol Data

Syntax  GS ( k pL pH cn fn m

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 48
fn = 82
m = 48

Default  None

Notes  This command encodes and sends the size information of the PDF417 symbol 
data in the symbol storage area. In Standard mode, this command is available only 
when the printer is at the beginning of a line or when the print buffer is empty.

The size information for the data is as follows:

The following indicates whether or not printing of the symbol is possible:

A quiet zone (the spaces surrounding the symbol such as upper, lower, left, and right 
spaces) is not included in the printing data. Make sure to include an adequate quiet 
zone for execution of this command.

ASCII GS ( k pL pH cn fn m
Hex 1D 28 6B 03 00 30 52 m
Decimal 29 40 107 3 0 48 82 m

Send data Hex Decimal Data

Header 37H 55 1 byte

Identifier 2FH 47 1 byte

Horizontal size 30H – 39H 48 – 57 1 – 5 byte

Separator 1FH 31 1 byte

Vertical size 30H – 39H 48 – 57 1 – 5 byte

Separator 1FH 31 1 byte

Fixed value 31H 49 1 byte

Separator 1FH 31 1 byte

Other information 30H or 31H 48 or 49 1 byte

NUL 00H 0 1 byte

Hex Decimal Condition

30H 48 Printing is possible

31H 49 Printing is impossible
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<Function 165> (fn = 65) — GS ( k pL pH cn fn n1 n2

Description  Set the QR Code Model

Syntax  GS ( k pL pH cn fn n1 n2

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 49 
fn = 65
n1 = 49, 50
n2 = 0

Default  n1 = 50 
n2 = 0

Notes  This command sets the QR Code model as follows:

The settings of this function affect the processing of <Function 181> (fn = 81) 
on page 87 and <Function 182> (fn = 82) on page 89.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS ( k pL pH cn fn n1 n2
Hex 1D 28 6B 04 00 31 41 n1 n2
Decimal 29 40 107 4 0 49 65 n1 n2

n1 Function

49 Model 1

50 Model 2
08/28/2018 Virtual Device-E User Guide P1067298-003



Commands
Virtual Device-E Commands

84
<Function 167> (fn = 67) — GS ( k pL pH cn n

Description  Set the Size of the QR Code Module

Syntax  GS ( k pL pH cn n

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)

cn = 49 

fn = 67

n = 0 to 9

Default  n = 3

Notes  This command sets the size of the QR Code module to n dots. Because a QR 
Code module is square, n = both the module width and the module height.

The settings of this function affect the processing of <Function 181> (fn = 81) 
on page 87 and <Function 182> (fn = 82) on page 89.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS ( k pL pH cn fn n
Hex 1D 28 6B 03 00 31 43 n
Decimal 29 40 107 3 0 49 67 n
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<Function 169> (fn = 69) — GS ( k pL pH cn n

Description  Set the Error Correction Level for QR Code

Syntax  GS ( k pL pH cn n

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 49 
fn = 69
n = 48 to 51

Default  n = 48

Notes  This command sets the error correction level for the QR Code. The printer 
uses Reed-Solomon correction to generate a series of error correction codewords.

The settings of this function affect the processing of <Function 181> (fn = 81) 
on page 87 and <Function 182> (fn = 82) on page 89.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS ( k pL pH cn fn n
Hex 1D 28 6B 03 00 31 45 n
Decimal 29 40 107 3 0 49 69 n

n Function Recovery Amount (%)

48 Error Correction Level L 7

49 Error Correction Level M 15

50 Error Correction Level Q 25

51 Error Correction Level H 30
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<Function 180> (fn = 80) — GS ( k pL pH cn fn m d1...dk

Description  Save QR Code Symbol Data

Syntax  GS ( k pL pH cn fn m d1...dk

Range  4 ? (pL + pH × 256) ? 7092 (pL = 0 to 255, pH = 0 to 27)
cn = 49
fn = 8
m = 48
d = 0 to 255
k = (pL + pH × 256) – 3

Default  None

Notes  This command saves the symbol data of the QR Code to the symbol storage 
area.

This function defines and stores the symbol data to the symbol storage area. 
<Function 181> (fn = 81) on page 87 prints that symbol data. The data remains 
reserved after completion of printing.

The following shows the data available for encoding a QR code.

This command remains in effect until the following processing is performed:

• Executing <Function 180> (fn = 80) on page 86

• Executing ESC @ on page 50

• The printer defaults are reset, or the printer is power cycled

ASCII GS ( k pL pH cn fn m d1...dk
Hex 1D 28 6B pL pH 31 50 30 d1...dk
Decimal 29 40 107 pL pH 49 80 48 d1...dk

Character Type Usable Characters

Numeric Data “0” ~ “9”

Alphanumeric Data “0” ~ “9”, “A” ~ “Z”, SP, $, %, *, +, -, ., /, :

Kanji Data Shift JIS value

8bit Byte Data 00H ~ FFH
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<Function 181> (fn = 81) — GS ( k pL pH cn fn m

Description  Encode and Print QR Code Symbol Data

Syntax  GS ( k pL pH cn fn m

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 49 
fn = 81
m = 48

Default  None

Notes  This command encodes and prints the QR Code symbol data that was saved 
in the symbol storage area.

In Standard mode, this command is available only when the printer is at the beginning 
of a line or when the print buffer is empty. The paper feed amount set by the paper 
feed setting command does not affect printing of the symbol. The printing position 
returns to the left side of the printable area after printing the symbol. In Page mode, 
the printer stores the symbol data in the print buffer without printing.

The printer cannot print a symbol that exceeds the printing area in size. Print modes 
(such as emphasized or double-strike) do not affect the printing of a symbol. 
Exceptions are the character size and upside-down printing.

Printing operation is not processed under the following conditions:

• There is no data. (<Function 180> (fn = 80) on page 86 is not executed)

• If (number of columns × number of rows) is less than the number of codewords, 
the numbers of columns and rows are automatically processed.

Based on the symbol data in the data storage area, the printer automatically selects 
the best compression mode from these four types:

• Numeric Data Code

• Alphanumeric Data mode

• Kanji Data mode

• 8 bit Data mode

The following data is added automatically by the encoding processing:

• Position sensor pattern

• Segregator for the position sensor pattern

• Timing pattern

• Format information

ASCII GS ( k pL pH cn fn m
Hex 1D 28 6B 03 00 31 51 m
Decimal 29 40 107 3 0 49 81 m
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• Version information

• Error correction code text

• Pad code text

• Indicator for counting bits of bytes

• Mode indicator

• Concluder

• Queue pattern (when model 2 is selected)

• Expansion pattern (when model 1 is selected)

A quiet zone (the spaces surrounding the symbol such as upper, lower, left, and right 
spaces) is not included in the printing data. Make sure to include an adequate quiet 
zone for execution of this command.
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<Function 182> (fn = 82) — GS ( k pL pH cn fn m

Description  Transmit Size Information for QR Code Symbol Data

Syntax  GS ( k pL pH cn fn m

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 49
fn = 82
m = 48

Default  None

Notes  This command transmits the size information of the QR Code symbol data that 
was encoded by <Function 180> (fn = 80) on page 86. In Standard mode, this 
command is available only when the printer is at the beginning of a line or when the 
print buffer is empty.

The size information of each data is as follows:

A quiet zone (the spaces surrounding the symbol such as upper, lower, left, and right 
spaces) is not included in the size information. Make sure to include an adequate 
quiet zone for execution of this command.

The following data indicates whether or not printing of the symbol is possible:

ASCII GS ( k pL pH cn fn m
Hex 1D 28 6B 03 00 31 52 m
Decimal 29 40 107 3 0 49 82 m

Send data Hex Decimal Data

Header 37H 55 1 byte

Flag 36H 54 1 byte

Horizontal size 30H – 39H 48 – 57 1 – 5 byte

Separator 1FH 31 1 byte

Vertical size 30H – 39H 48 – 57 1 – 5 byte

Separator 1FH 31 1 byte

Fixed Value 31H 49 1 byte

Separator 1FH 31 1 byte

Other Information 30H or 31H 48 or 49 1 byte

NUL 00H 0 1 byte

Hex Decimal Condition

30H 48 Printing is possible

31H 49 Printing is impossible
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<Function 265> (fn = 65) — GS ( k pL pH cn fn n1 n2

Description  Set the Mode for MaxiCode

Syntax  GS ( k pL pH cn fn n1 n2

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 50
fn = 65
n = 50 to 52

Default  n = 50

Notes  This command selects the mode for MaxiCode:

The settings of this function affect the processing of <Function 281> (fn = 81) 
on page 92.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS ( k pL pH cn fn n
Hex 1D 28 6B 03 00 32 41 n
Decimal 29 40 107 3 0 50 65 n

n Function

50 Mode 2 setting

51 Mode 3 setting

52 Mode 4 setting
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<Function 280> (fn = 80) — GS ( k pL pH cn fn m d1...dk

Description  Store the MaxiCode Symbol Data

Syntax  GS ( k pL pH cn fn m d1...dk

Range  4 ? (pL + pH × 256) ? 141 (pL = 4 to 141, pH = 0)
cn = 50
fn = 80
m = 48
d = 0 to 255
k = (pL + pH × 256) – 3

Default  None

Notes  This command stores Maxi Code symbol data in the symbol storage area.

The data stored in the symbol storage area by this command is processed by 
<Function 281> (fn = 81) on page 92. The data remains reserved in the storage.

This command remains in effect until the following processing is performed:

• Executing <Function 280> (fn = 80) on page 91

• Executing ESC @ on page 50

• The printer defaults are reset, or the printer is power cycled

ASCII GS ( k pL pH cn fn m d1...dk
Hex 1D 28 6B pL pH 32 50 30 d1...dk
Decimal 29 40 107 pL pH 50 80 48 d1...dk
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<Function 281> (fn = 81) — GS ( k pL pH cn fn m

Description  Encode and Print MaxiCode Symbol Data

Syntax  GS ( k pL pH cn fn m

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 50
fn = 81
m = 48

Default  None

Notes  This command encodes and prints the Maxi Code symbol data that was saved 
in the storage area. The printer uses Reed-Solomon correction to generate a series of 
error correction codewords.

In Standard mode, this command is available only when the printer is at the beginning 
of a line or when the print buffer is empty. The paper feed amount set by the paper 
feed setting command does not affect printing of the symbol. The printing position 
returns to the left side of the printable area after printing the symbol. In Page mode, 
the printer stores the symbol data in the print buffer without printing.

The printer cannot print a symbol that exceeds the printing area in size. 

Printing operation is not processed under the following conditions:

• There is no data. (<Function 280> (fn = 80) on page 91 is not executed)

• The number of numeric characters exceeds 138

• The number of alphanumeric characters exceeds 93

When mode 2 is selected, the primary message does not include the following:

When mode 3 is selected, the primary message does not include the following:

ASCII GS ( k pL pH cn fn m
Hex 1D 28 6B 03 00 32 51 m
Decimal 29 40 107 3 0 50 81 m

Primary Message Data Number Character

Postal code 1~9 Numeric

ISO country code 1~3 Numeric

Service type code 1~3 Numeric

Primary Message Data Number Character

Postal code 1~6 Setting Code A

ISO country code 1~3 Numeric

Service type code 1~3 Numeric
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Modes 2 and 3 are executed according to the following. 

• 9-byte data including [)>, RS, 01, GS, and yy are regarded as the Header. (RS 
and GS indicate MAXI CODE control code while y indicates the 2-byte numeric 
data.)

• The data that immediately follows the Header is the Primary Message.

• When printing, the Header is placed at the beginning of the Secondary 
Message.

• When Header data is absent, the data are regarded as Primary Message.

• In the Primary Message, GS is used as the separator that divides message into 
Postal code, ISO country code, and Class of service. This GS is ignored.

• All data of the Secondary Message is regarded as symbol data.

In modes 4, 5, and 6, the printer regards all of the data in the symbol storage area as 
Primary Message and Secondary Message.

The following data is automatically added during the encoding process:

• Position sensor pattern

• Position pattern

• Error correction code text

• Mode separator

• Pad code text

A quiet zone (the spaces surrounding the symbol such as upper, lower, left, and right 
spaces) is not included in the printing data. Make sure to include an adequate quiet 
zone for execution of this command.
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<Function 367> (fn = 67) — GS ( k pL pH cn n

Description  Set the Data Matrix Code Size

Syntax  GS ( k pL pH cn n

Range  (pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 51
fn = 67
n = 2 to 3

Default  n = 3

Notes  This command sets the Data Matrix Code size. Because a Data Matrix Code 
module is square, n = both the module width and the module height.

The settings of this function affect the processing of <Function 381> (fn = 81) 
on page 96.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS ( k pL pH cn fn n
Hex 1D 28 6B 03 00 33 43 n
Decimal 29 40 107 3 0 51 67 n
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<Function 380> (fn = 80) — GS ( k pL pH cn fn m d1...dk

Description  Store the Data Matrix Symbol Data

Syntax  GS ( k pL pH cn fn m d1...dk

Range  0 ? (pL + pH × 256) ? 3116 (pL = 0 to 255, pH = 0 to 13)
cn = 51
fn = 80
m = 48
d = 0 to 255
k = (pL + pH × 256) – 3

Default  None

Notes  This command stores the Data Matrix symbol data in the symbol storage area. 
The data stored to the symbol storage area by this command is executed by 
<Function 381> (fn = 81) on page 96. The data remains reserved in the symbol 
storage area.

This command remains in effect until the following processing is performed:

• Executing <Function 380> (fn = 80) on page 95

• Executing ESC @ on page 50

• The printer defaults are reset, or the printer is power cycled

ASCII GS ( k pL pH cn fn m d1...dk
Hex 1D 28 6B pL pH 33 50 30 d1...dk
Decimal 29 40 107 pL pH 51 80 48 d1...dk
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<Function 381> (fn = 81) — GS ( k pL pH cn fn m

Description  Encode and Print Data Matrix Symbol Data

Syntax  GS ( k pL pH cn fn m

Range  pL + pH × 256) = 3 (pL = 3, pH = 0)
cn = 51
fn = 81
m = 48

Default  None

Notes  This command encodes and prints the Data Matrix symbol data saved in the 
storage area. The printer uses Reed-Solomon correction to generate a series of error 
correction codewords.

In Standard mode, this command is available only when the printer is at the beginning 
of a line or when the print buffer is empty.

A symbol exceeding the printing area in size can not be printed.

Printing operation is not processed under the following conditions:

• There is no data. (<Function 380> (fn = 80) on page 95 cannot be executed)

• The number of alphanumeric characters exceeds 2334.

• The number of 8 bit byte characters exceeds 1558.

• The number of numeric characters exceeds 3116.

Data Matrix uses ECC 200 symbols.

The following data is automatically added during the encoding process:

• Position pattern

• Error correction code text

• Mode separator

• Pad code text

In Standard mode, the paper feed amount set by the paper feed setting command 
does not affect printing of the symbol. The printing position returns to the left side of 
the printable area after printing the symbol. In Page mode, the printer stores the 
symbol data in the print buffer without executing actual printing.

A quiet zone (the spaces surrounding the symbol such as upper, lower, left, and right 
spaces) is not included in the printing data. Make sure to include an adequate quiet 
zone for execution of this command.

ASCII GS ( k pL pH cn fn m
Hex 1D 28 6B 03 00 33 51 m
Decimal 29 40 107 3 0 51 81 m
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GS ( E

Description  Set Nonvolatile User Memory Area

Notes  GS (E stores the customized values to the nonvolatile user memory area and 
uses them for printer operation. The table below explains the functions available in 
this command.

pL and pH are used to set the number of bytes that follow pH to (pL + pH × 256).

You must enter the user setting mode to change the items of the nonvolatile user 
memory. After the user setting mode is terminated (<Function 2> (fn = 2) on page 99), 
the printer resets its software and restores the initial settings in effect at power on. 
Receive and print buffers also are cleared.

fn Format No. Purpose

1 GS ( E pL pH fn d1 d2 1 Start the user setting mode

2 GS ( E pL pH fn d1 d2 d3 2 End the user setting mode 
(performs a soft reset)

3 GS ( E pL pH fn [a1 b18...b11]...

[ak bk8...bk1]

3 Set value(s) for the memory 
switch

4 GS ( E pL pH fn a 4 Transmit the settings of the 
memory switch to the host

11 GS ( E pL pH fn a d1...dk 11 Set the communication 
conditions for the serial interface

12 GS ( E pL pH fn a 12 Transmit the communication 
conditions for the serial interface
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<Function 1> (fn = 1) — GS ( E pL pH fn d1 d2

Description  Start User Setting Mode

Syntax  GS ( E pL pH fn d1 d2

Range  (pL + pH × 256) = 3, (pL = 3, pH = 0)
fn = 1
d1 = 73
d2 = 78

Default  None

Notes  This function enables User Setting mode. Enable this mode before processing 
Functions 2 through 12. If User Setting mode is not enabled, those functions are 
ignored.

Mode change feedback enables the printer to notify that the mode has changed as 
follows:

After the printer enters the user setting mode by this command, the printer transmits 
“mode change feedback” to the host. After confirming that this was sent to the host, 
send the command to reconfigure the nonvolatile user memory.

This command is effective only in Standard mode.

ASCII GS ( E pL pH fn d1 d2
Hex 1D 28 45 pL pH fn d1 d2
Decimal 29 40 69 pL pH fn d1 d2

Hexadecimal Decimal Number of Data

Header 37H 55 1 byte

Flag 20H 32 1 byte

NUL 00H 0 1 byte
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<Function 2> (fn = 2) — GS ( E pL pH fn d1 d2 d3

Description  End User Setting Mode

Syntax  GS ( E pL pH fn d1 d2 d3

Range  (pL + pH × 256) = 4 (pL = 4, pH = 0)
fn = 2
d1 = 79
d2 = 85
d3 = 84

Default  None

Notes  This command terminates the user setting mode and performs a software 
reset. After the reset, the printer resets its software and restores the initial settings in 
effect at power on. 

All changes in settings that are made in user setting mode take effect only after this 
command is executed.

ASCII GS ( E pL pH fn d1 d2 d3
Hex 1D 28 45 pL pH fn d1 d2 d3
Decimal 29 40 69 pL pH fn d1 d2 d3
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<Function 3> (fn = 3) — GS ( E pL pH fn [a1 b18...b11]...[ak bk8...bk1]

Description  Change Memory Switch Values

Syntax  GS ( E pL pH fn [a1 b18...b11]...[ak bk8...bk1]

Range  10 ? (pL + pH × 256) ? 65535
fn = 3
a = 1, 2, 5, 6, 7, 8 
b = 48, 49, 50
k = 1 to 10

Default  Varies based on the printer model

Notes  This command simultaneously changes Memory Switches (Msw) 1 through 8 
to the value specified by b in the following way:

• When b = 48, 49, the corresponding bits are set to Off and On, respectively.

• When b = 50, no change occurs in the memory switch.

ASCII GS ( E pL pH fn [b18...b11]... [bk8...bk1]
Hex 1D 28 45 pL pH fn [b18...b11]... [bk8...bk1]
Decimal 29 40 69 pL pH fn [b18...b11]... [bk8...bk1]

Msw Value Function

Settings for memory switch 1
3 2 1

1-1~3 48 48 48 Print density 130%

48 48 49 Print density 120%

48 49 48 Print density 110%

48 49 49 Print density 150%

49 48 48 Print density 100%

49 48 49 Print density 140%

49 49 48 Print density 90%

49 49 49 Print density 80%

1-4 48 2-byte character mode not selected

49 2-byte character mode selected

1-5 48 Print speed 90 mm/sec

49 Print speed 50 mm/sec

1-6 48 Reserved
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• The print density adjusts the darkness of characters to be printed.

• 2-byte character mode is selected to support for Chinese, Japanese, and Korean 
model.

• The printer supports printing speeds of 80 mm/sec and 50 mm/sec. Slower print 
speeds may give better print quality.

Code page selection using memory switch 2-3 through 2-8 is as follows.

The settings for memory switch 5 are as follows.

Specify the length of idle time before the printer enters the power-down mode. The 
idle time can be from 0 to 90 seconds. When the memory switch value is 0, the power-
down mode is not active

Settings for memory switch 2

2-1 48 Font selection: Font A

49 Font selection: Font B

2-2 48 Not supported

49 Not supported

Msw Value Function

Msw2-8 Msw2-7 Msw2-6 Msw2-5 Msw2-4 Msw2-3 Character Table

48 48 48 48 48 48 PC437

48 48 48 49 48 48 PC850

MSW5-8 MSW5-7 MSW5-6 MSW5-5 MSW5-4 MSW5-3 MSW5-2 MSW5-1
Value
(Sec)

48 48 48 48 48 48 48 48 0

48 48 48 48 48 48 48 49 1

48 48 48 48 48 48 49 48 2

48 48 48 48 48 48 49 49 3

48 48 48 48 48 49 48 48 4

. . . . . . . .

. . . . . . . .

. . . . . . . .

48 49 48 49 49 48 49 48 90
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The settings for memory switch 6 are as follows.

Set the standby time before the printer enters the power saving mode. The standby 
time can be from 10 to 255 seconds. When memory switch value is 0, the power 
saving mode does not work.

Memory switch 7 is not supported.

The settings for memory switch 8 are as follows:

• Either the character font A or B or C is selected.

• The beep is activated for the audible paper empty warning signal.

• The beep is activated for the audible low battery warning signal.

• The label printing is available by the setting.

MSW6-8 MSW6-7 MSW6-6 MSW6-5 MSW6-4 MSW6-3 MSW6-2 MSW6-1 Value

48 48 48 48 49 48 49 48 10

48 48 48 48 49 48 49 49 11

48 48 48 48 49 49 48 48 12

48 48 48 48 49 49 48 49 13

48 48 48 48 49 49 49 48 14

. . . . . . . .

. . . . . . . .

. . . . . . . .

49 49 49 49 49 49 49 49 255

Msw Setting Value Function

8-1

8-2

8-3 48 No beeps for roll paper end

49 Beeps for roll paper end

8-4 48 Beeps for low battery status

49 No beeps low battery status

8-5 49 Reserved

8-6 Not supported

8-7

8-8 48 Reserved

Function MSW 8-2 MSW 8-1

Select font 12x24 48 48

Select font 9x24 48 49

Select font 9x17 49 48
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<Function 4> (fn = 4) — GS ( E pL pH fn a

Description  Transmit Memory Switch Value

Syntax  GS ( E pL pH fn a

Range  (pL + pH × 256) = 2 (pL = 2, pH = 0)
fn = 4
a = 1, 2, 5, 6, 7, 8

Default  None

Notes  This command transmits the setting value of the memory switch 
corresponding to a.

The setting value is sent from bit 8 to bit 1, consisting of 8 bytes in total.

• Off: Hexadecimal = 30H / Decimal = 48

• On: Hexadecimal = 31H / Decimal = 49

ASCII GS ( E pL pH fn a
Hex 1D 28 45 pL pH fn a
Decimal 29 40 69 pL pH fn a

Hexadecimal Decimal Amount of Data

Header 37H 55 1 byte

Identifier 21H 33 1 byte

Setting value 30H or 31H 48 or 49 8 bytes

NUL 00H 0 1 byte
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<Function 11> (fn = 11) — GS ( E pL pH fn a d1…dk

Description  Set Serial Interface Configuration

Syntax  GS ( E pL pH fn a d1…dk

Range  3 ? (pL + pH × 256) ? 8, (pL = 3 to 8, pH = 0)
fn = 11 a = 1 to 4
d = 48 to 57 [a = 1]
d = 48 to 50 [a = 2] 
d = 48, 49 [a = 3] 
d = 55,56   [a = 4]
k = 1 to 6

Default  
d1...dk = “115200” [a = 1]
d = 48 [a = 2] 
d = 48 [a = 3] 
d = 56 [a = 4]

Notes  Sets the configuration item for the serial interface specified by a to the values 
specified by d1...dk.

Transmission speed (a = 1) is specified by number.

Example: When defining 19200 bps: 5 bytes d1…dk “19200”(Hexadecimal = 31H, 
39H, 32H, 30H, 30H / Decimal = 49, 57, 50, 48, 48)

ASCII GS ( E pL pH fn a d1 dk
Hex 1D 28 45 pL pH 0B a d1 dk
Decimal 29 40 69 pL pH 11 a d1 dk

a Configuration item

1 Transmission speed

2 Parity

3 Flow control

4 Data length
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Baud rate is specified as follows: (k = 1 to 6)

Parity (a = 2) is specified by d as follows:

Flow control (a = 3) is specified by d as follows:

Data Length (a = 4) is specified by d14 as follows:

d11~dk1 Function

“115200” Baud rate 115200

“57600” Baud rate 57600

“38400” Baud rate 38400

“19200” Baud rate 19200

“9600” Baud rate 9600

“4800” Baud rate 4800

“2400” Baud rate 2400

d Function

48 Select no parity

49 Select odd parity

50 Select even parity

d Function

48 Select flow control DTR/DSR

49 Select flow control XON/XOFF

d Function

55 Select 7 bits length

56 Select 8 bits length
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<Function 12> (fn = 12) — GS ( E pL pH fn a

Description  Transmit Serial Interface Conditions

Syntax  GS ( E pL pH fn a

Range  (pL + pH × 256) = 2 (pL = 2, pH = 0)
fn = 12
a = 1 to 4

Default  None

Notes  This command transmits the communication conditions of the serial interface.

The data format to be transmitted is as follows:

ASCII GS ( E pL pH fn a
Hex 1D 28 45 pL pH fn a
Decimal 29 40 69 pL pH fn a

a Communication Condition

1 Baud rate

2 Parity

3 Flow control

4 Data length

Hexadecimal Decimal Amount of Data

Header 37H 55 1 byte

Identifier 33H 39 1 byte

Communication 
condition (a)

31H - 34H 49 - 52 1 byte

Separator 1FH 31 1 byte

Setting value 30H - 39H 48 - 57 1 - 6 bytes

NUL 00H 0 1 byte
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Communication condition is defined by a and setting value defined as shown in the 
following. When the baud rate (a = 1) is specified:

When the parity setting (a = 2) is specified:

When the flow control setting (a = 3) is specified:

When the data length setting (a = 4) is specified:

Baud rate 
(bps)

d1 d2 d3 d4 d5 d6

2400 50 52 48 48 -- --

4800 52 56 48 48 -- --

9600 57 54 48 48 -- --

19200 49 57 50 48 48 --

38400 51 56 52 48 48 --

57600 53 55 54 48 48 --

115200 49 49 53 50 48 48

d1 Parity

48 No parity

49 Odd parity

50 Even parity

d1 Flow control

48 DTR / DSR (Fixed)

49 XON / XOFF

d1 Data length

55 7 bits

56 8 bits
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GS ( L, GS 8 L

Description  Process Graphics Data

Syntax  GS(L

GS8L

Notes  These commands process graphics data according to the function code (fn). 
They are adapted to print image data.

pL and pH specify the number of bytes following pH using (pL + pH × 256).

<Function 48> (fn = 0, 48) — GS ( L pL pH m fn

Description  Transmit the Capacity of the Nonvolatile Bit Image Memory

ASCII GS ( L pL pH m fn [parameter]
Hex 1D 28 4C pL pH m fn [parameter]

Decimal 29 40 76 pL pH m fn [parameter]

ASCII GS 8 L p1 p2 p3 p4 m fn [parameter]

Hex 1D 38 4C p1 p2 p3 p4 m fn [parameter]

Decimal 29 56 76 p1 p2 p3 p4 m fn [parameter]

fn Format Function No. Function

0, 
48

GS ( L pL pH m fn Function 48 Transmits the nonvolatile 
graphics memory capacity.

2, 
50

GS ( L pL pH m fn Function 50 Prints the graphics data in the 
print buffer.

3, 
51

GS ( L pL pH m fn Function 51 Transmits the remaining capacity 
of the nonvolatile graphics 
memory.

64 GS ( L pL pH m fn d1 d2 Function 64 Transmits the defined nonvolatile 
graphics key code list.

65 GS ( L pL pH m fn d1 d2 d3 Function 65 Deletes all nonvolatile graphics 
data.

66 GS ( L pL pH m fn kc1 kc2 Function 66 Deletes the specified nonvolatile 
graphics data.

67 GS ( L pL pH m fn a kc1 kc2 b xL xH 
yL yH [c d1...dk]1...[c d1 dk]b

Function 67 Defines the raster graphics data 
in the nonvolatile memory.

69 GS ( L pL pH m fn kc1 kc2 x y Function 69 Prints the specified nonvolatile 
graphics data.

112 GS ( L pL pH m fn a bx by c xL xH

yL yH d1...dk

Function 112 Stores the raster graphics data in 
the print buffer memory.
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Syntax  GS ( L pL pH m fn

Range  (pL + pH × 256) = 2 (pL = 2, pH = 0)
m = 48
fn = 0, 48

Default  None

Notes  Transmits the total capacity of the nonvolatile bit image memory (number of 
bytes in the memory area). The total capacity data is converted to character codes 
that correspond to decimal data, and then transmitted from the Most Significant Bit 
(MSB).

This command is available in Standard mode and Page mode.

<Function 50> (fn = 2, 50) — GS ^ L pL pH fn

Description  Print the Graphics Data

Syntax  GS ^ L pL pH fn

Range  (pL + pH × 256) = 2 (pL = 2, pH = 0)

m = 48
fn = 2, 50

Default  None

Notes  This command prints the graphics data that is stored in the print buffer. The 
graphics data are defined by <Function 112> (fn = 112) on page 115.

The printer uses the required amount of line feed pitch for printing graphics data, 
regardless of the existing setting value for the line feed pitch.

This command is available in Standard mode and Page mode.

ASCII GS ( L pL pH m fn
Hex 1D 28 4C pL pH m fn
Decimal 29 40 76 pL pH m fn

Hexadecimal Decimal Amount of Data

Header 37H 55 1 byte

Flag 30H 48 1 byte

Data 30H - 39H 48 - 57 1 - 8 bytes

NUL 00H 0 1 byte

ASCII GS ( L pL pH m fn
Hex 1D 28 4C pL pH m fn
Decimal 29 40 76 pL pH m fn
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<Function 51> (fn = 3, 51) — GS ( L pL pH m fn

Description  Transmit Amount of Unused Nonvolatile User Memory

Syntax  GS ( L pL pH m fn

Range  (pL + pH × 256) = 2 (pL = 2, pH = 0)
m = 48
fn = 3, 51

Default  None

Notes  Transmits the amount of unused memory (in bytes) in the nonvolatile user 
memory. The number of bytes of remaining memory is converted to character codes 
that correspond to decimal data, which is then transmitted from the MSB. The data 
length is variable.

ASCII GS ( L pL pH m fn
Hex 1D 28 4C pL pH m fn
Decimal 29 40 76 pL pH m fn

Hexadecimal Decimal Amount of Data

Header 37H 55 1 byte

Flag 31H 49 1 byte

Data 30H – 39H 48 - 57 1 - 8 bytes

NUL 00H 0 1 byte
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<Function 64> (fn = 64) — GS ( L pL pH m fn d1 d2

Description  Transmit the Nonvolatile Graphics Key Code List

Syntax  GS ( L pL pH m fn d1 d2

Range  (pL + pH × 256) = 4 (pL = 4, pH = 0)
m = 48 
fn = 64
d1 = 75
d2 = 67

Default  None

Notes  Transmits the defined nonvolatile graphics key code list.

When the key code is present:

When the key code is not present:

<Function 65> (fn = 65) — GS ( L pL pH m fn d1 d2 d3

Description  Delete All Defined Nonvolatile Graphics Data

Syntax  GS ( L pL pH m fn d1 d2 d3

ASCII GS ( L pL pH m fn d1 d2
Hex 1D 28 4C pL pH m fn d1 d2
Decimal 29 40 76 pL pH m fn d1 d2

Hexadecimal Decimal Amount of Data

Header 37H 55 1 byte

Flag 72H 114 1 byte

Status 40H or 41H 64 or 65 1 byte

Data 30H - 39H 48 - 57 2 - 80 bytes

NUL 00H 0 1 byte

Hexadecimal Decimal Amount of Data

Header 37H 55 1 byte

Flag 72H 114 1 byte

Status 40H 64 1 byte

NUL 00H 0 1 byte

ASCII GS ( L pL pH m fn d1 d2 d3
Hex 1D 28 4C pL pH m fn d1 d2 d3
Decimal 29 40 76 pL pH m fn d1 d2 d3
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Range  (pL + pH × 256) = 5 (pL = 5, pH = 0)
m = 48
fn = 65
d1 = 67
d2 = 76
d3 = 82

Default  None

Notes  This command removes all defined nonvolatile graphics data. The graphics 
data is defined by <Function 67> (fn = 67) on page 113 into the nonvolatile graphics 
memory with a sector dedicated for storing nonvolatile graphics data.

<Function 66> (fn = 66) — GS ( L pL pH m fn kc1 kc2

Description  Delete Nonvolatile Graphics Data kc1 and kc2

Syntax  GS ( L pL pH m fn kc1 kc2

Range  (pL + pH × 256) = 4 (pL = 4, pH = 0)
m = 48
fn = 66
kc1 = 32 to 126
kc2 = 32 to 126

Default  None

Notes  This command deletes the nonvolatile graphics data corresponding to kc1 and 
kc2. kc1 and kc2 exist in each of the graphics data groups to be stored into the 
nonvolatile graphics memory in the order of download.

The graphics data is defined by <Function 67> (fn = 67) on page 113.

ASCII GS ( L pL pH m fn kc1 kc2
Hex 1D 28 4C pL pH m fn kc1 kc2
Decimal 29 40 76 pL pH m fn kc1 kc2
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<Function 67> (fn = 67) — GS ( L pL pH m fn a kc1 kc2 b xL xH yL yH 
[c d1...dk]1...[c d1...dk]b

Description  Define Raster Graphics Data in the Nonvolatile Graphics Area

Syntax  GS ( L pL pH m fn a kc1 kc2 b xL xH yL yH [c 
d1...dk]1...
[c d1...dk]b

Range  

• b specifies the number of the color of the defined data.

• xL, xH specifies the defined data in the horizontal direction to (xL + xH × 256) dots.

• yL, yH specifies the defined data in the vertical direction to (yL + yH × 256) dots.

• c specifies the color of the defined data.

When using GS ( L:

3 ? (pL + pH × 256) ? 65535 (pL = 0 to 255, pH = 0 to 255)

When using GS 8 L

12 ? (p1 + ? 256 + p3 ? 65536 + p4 ?16777216) ? 253119]
m = 48
fn = 67
a = 48
kc1 = 32 to 126
kc2 = 32 to 126
b = 1, 2
1 ? (xL + xH × 256) ? 384
1 ? (yL + yH × 256) ? 1662 
c = 49
d = 0 to 255
k = (int ( ( xL + xH × 256) + 7) / 8) × (yL + yH × 256)

Default  None

Notes  This command defines the raster graphics data in the nonvolatile graphics 
area. The total capacity of the nonvolatile graphic memory is 256 K bytes

ASCII GS ( L pL pH m fn a kc1 kc2 b xL xH yL yH 
[c d1...dk]1...[c d1...dk]b d1...dk]b

Hex 1D 28 4C pL pH m fn a kc1 kc2 b xL xH yL yH 
[c d1...dk]1...[c d1...dk]b d1...dk]b

Decimal 29 40 76 pL pH m fn a kc1 kc2 b xL xH yL yH 
[c d1...dk]1...[c d1...dk]b d1...dk]b

c Defined data color

49 Color 1 (black)
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<Function 69> (fn = 69) — GS ( L pL pH m fn kc1 kc2 x y

Description  Print Nonvolatile Graphics Data kc1 and kc2

Syntax  GS ( L pL pH m fn kc1 kc2 x y

Range  (pL + pH × 256) = 6 (pL = 6, pH = 0)
m = 48
fn = 69
kc1 = 32 to 126
kc2 = 32 to 126
x = 1, 2
y = 1, 2

Default  None

Notes  Prints the nonvolatile graphics data defined by the key codes kc1 and kc2. 
The graphics data is enlarged by x and y in the horizontal and vertical directions. This 
command prints the nonvolatile graphics data defined by <Function 67> (fn = 67) 
on page 113.

The printer does not print nonvolatile graphics data beyond the print area for one line.

This command is available in Standard mode and Page mode.

ASCII GS ( L pL pH m fn kc1 kc2 x y
Hex 1D 28 4C pL pH m fn kc1 kc2 x y
Decimal 29 40 76 pL pH m fn kc1 kc2 x y
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<Function 112> (fn = 112) — GS ( L pL pH m fn a bx by c xL xH yL yH d1...dk

Description  Store the Raster Graphics Data in the Print Buffer

Syntax  GS ( L pL pH m fn a bx by c xL xH yL yH d1...dk

Range  11 ? (pL + pH × 256) ? 65535 (pL = 0 to 255, pH = 0 to 255)

Common settings:
m = 48
fn = 112
a = 48
bx = 1, 2
by = 1, 2
c = 49
1 ? (xL + xH × 256) ? 384
1 ? (yL + yH × 256) ? 1662 (when by = 1)
k = (int ( ( xL + xH × 256) + 7) / 8) × (yL + yH × 256)

Default  None

Notes  This command stores the raster graphics data in the print buffer, enlarged by 
bx and by in the horizontal and vertical directions.

• xL, xH specifies the raster graphics data in the horizontal direction as (xL + xH × 
256) dots.

• yL, yH specifies the raster graphics data in the vertical direction to (yL + yH × 256) 
dots.

• d denotes the stored data (raster format).

• k denotes the number of the graphics data.

• c specifies the color of the defined data.

Real-time commands are not processed during processing of this command.

ASCII GS ( L pL pH m fn a bx by c xL xH yL yH d1...dk

Hex 1D 28 4C pL pH m fn a bx by c xL xH yL yH d1...dk

Decimal 29 40 76 pL pH m fn a bx by c xL xH yL yH d1...dk

c Defined data color

49 Color 1 (black)
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GS :

Description  Start/End Macro Definition

Syntax  GS:

Notes  This command starts or ends macro definition. The macro is executed by GS ̂  
on page 124.

The printer starts macro definition during normal operation and finishes it upon 
receiving this command. The printer can continue to print during macro definition.

The maximum amount of macro data that can be defined varies based on the printer 
model. Any data that exceeds the printer’s limit is not stored.

ESC @ on page 50 does not clear an existing defined macro. The macro remains 
effective until the printer is reset or power cycled.

GS B 

Description  Turn Reverse Printing Mode On/off.

Syntax  GSBn

Range  n = 0 to 255

Default  n = 0

Notes  This command selects white/black reverse printing mode by setting the least 
significant bit (LSB) of n.

• When the LSB of n is 0, white/black reverse mode is turned off.

• When the LSB of n is 1, white/black reverse mode is turned on.

Multi-byte characters such as Kanji, Japanese and Korean are not reversed by this 
command, and underline mode is not effective. The right space defined by ESC SP 
on page 45 is included in the area reversed by this command. 

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS :
Hex 1D 3A
Decimal 29 58

ASCII GS B n
Hex 1D 42 n
Decimal 29 66 n
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GS H

Description  Selects Print Position of HRI Characters

Syntax  GSHn

Range  n = 0 to 3, 48 to 51

Default  n = 0

Notes  GS H specifies where Human Readable Interpretation (HRI) characters are 
positioned when printing a barcode. The print position is set according to the value of 
n:

The font of the HRI characters is defined by GS f on page 127.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS H n
Hex 1D 48 n
Decimal 29 72 n

n Print position

0, 48 Not printed

1, 49 Above the barcode

2, 50 Below the barcode

3, 51 Both above and below the barcode
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GS I

Description  Transmit Printer ID

Syntax  GSIn

Range  n = 1 to 69

Default  None

Notes  GS I transmits the printer ID or specified information.

Transmits 1 byte of printer ID or information, using n as follows:

Transmits specified printer information, using n as follows:

Printer information (when n = 65, 66, 67, or 69) consists of [Header ~ NULL] data:

The firmware version can be confirmed by self-test printing.

ASCII GS I n
Hex 1D 49 n
Decimal 29 73 n

n Printer ID Specification

1, 49 Printer model ID Printer model

2, 50 Type ID Printer type

3, 51 Printer feature ID Printing method and Printer size

65 Firmware version Firmware version

66 Manufacturer ZEBRA TECHNOLOGIES

67 Printer model Printer model

69 Code page Currently enabled code page

Transmitted data Hex Decimal Amount of data

Header 5FH 95 1 byte

Printer information Varies by printer model Varies by printer model 0 to 15 bytes

NUL 00H 0 1 byte
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Differences  The printer ID is shown according to printer models as follows:

GS I b

Description  Transmit Battery Status

Syntax  GSIb

Notes  GS I transmits the battery power status of the printer.

The [Header ~ NUL] data is transmitted as follows:

The printer indicates the remaining battery power as follows:

Printer ID Definition

1 (printer model ID) 0x41

2 (type ID) Type ID varies depending on functions the printer supports as follows:

- 0x01 (Multi-byte character)

3 (printer feature ID) 0x69

66 (manufacturer) Zebra Technologies

67 (printer model) Printer model name

69 (language of font) Code page currently being used. Refer to cod page setting command, 
ESC t.

ASCII GS I b
Hex 1D 49 62
Decimal 29 73 98

Transmitted data Hex Decimal Amount of data

Header 37H 55 1byte

Identifier 45H 69 1byte

Remaining battery power 30h to 34H 48-52 1byte

NUL 00H 0 1byte

Hex Decimal Remaining battery power level

30H 48 Full (F)

31H 49 High (H)

32H 50 Middle (M)

33H 51 Low (L)
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GS L

Description  Set Left Margin

Syntax  GSLnLnH

Range  nL = 0 to 255
nH = 0 to 255

Default  (nL + nH × 256) = 0 (nL = 0, nH = 0)

Notes  GS L adjusts the size of the left margin according to the following:
[(nL + nH × 256) × (horizontal motion units)]

Use GS W on page 122 to adjust the print area width. If the adjustment value 
specified exceeds the printable area for the left margin, the printer defaults the left 
margin to the maximum value allowed.

This command is ineffective in Page mode. If the left margin is enabled in Page mode, 
the setting takes effect when the printer returns to Standard mode.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS L nL nH
Hex 1D 4C nL nH
Decimal 29 76 nL nH
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GS T

Description  Set Print Position to Beginning of Print Line

Syntax  GSTn

Range  n = 0, 1, 48, 49

• When n = 1, 49, the printer prints the data in the print buffer and executes a 
line feed, based on the line feed amount specified.

• When n = 0, 48, the printer removes the print data in the print buffer.

Default  None

Notes  This command sets the print position to the beginning of the print line. n 
specifies when this command is executed relative to when the data in the print buffer 
is processed as follows:

This command is effective only in Standard mode and is ignored in Page mode.

After the printer processes this command, the print buffer is empty, and the printer 
moves the print position to the left of the print area. The printer ignores this command 
if the print position is already the beginning of the line.

ASCII GS T n
Hex 1D 54 n
Decimal 29 84 n

n Function

0, 48 Sets the print position after the data in the print buffer is deleted.

1, 49 Sets the print position after the data in the print buffer is printed.
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GS W

Description  Set Printing Area Width

Syntax  GSWnLnH

Range  0 ? nL ? 255, 0 ? nH ? 255

Default  (nL + nH × 256) = 384 (nL = 80, nH = 1)

Notes  GS W adjusts the width of the print area according to the following:
[(nL + nH × 256) × (horizontal motion units)]

Use GS L on page 120 to adjust the print area width. If the adjustment value specified 
exceeds the printable area for the print area, the printer defaults the print area to 

(printable area – left margin)

This command is ineffective in Page mode. If the print area width is enabled in Page 
mode, the setting takes effect when the printer returns to Standard mode.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS W nL nH
Hex 1D 57 nL nH
Decimal 29 87 nL nH
P1067298-003 Virtual Device-E User Guide 08/28/2018



123Commands
Virtual Device-E Commands
GS \

Description  Set Relative Vertical Print Position (Page Mode)

Syntax  GS\

Range  nL = 0 to 255
nH = 0 to 255

Default  None

Notes  In Page mode, GS \ moves the vertical print position to a position relative to 
the current one according to the following:

[(nL + nH × 256) × (vertical or horizontal motion units)]

The command is ignored in Standard mode. The printer ignores any setting that 
exceeds the print area set by ESC W on page 58.

The horizontal motion unit is used for the calculation when the print start position is 
defined to the upper right or lower right of print area (using ESC T on page 57). 
Otherwise, the vertical motion unit is used.

ASCII GS \ nL nH

Hex 1D 5C nL nH
Decimal 29 92 nL nH
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GS ^

Description  Execute Macro

Syntax  GS^rtm

Range  r = 0 to 255
t = 0 to 255
m = 0, 1

Default  None

Notes  A macro can be used to print the same data repeatedly. This command 
executes a macro using parameters as following:

• r = the number of times to execute the macro.

• t = the waiting time before the macro is executed.

• m = macro executing mode.

The macro is defined by GS : on page 116. If the macro is not defined or if r = 0, the 
command is ignored.

ASCII GS ^ r t m
Hex 1D 5E r t m
Decimal 29 94 r t m

m Function

0 Executes the macro r times continuously at the interval specified by t.

1 The printer waits for the paper FEED button to be pressed for the time 
specified by t. The macro is executed once when the button is 
pressed. This operation is repeated r times.
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GS a

Description  Enable/Disable Automatic Status Back

Syntax  GSan

Range  n = 0 to 255

Default  n = 0

Notes  This enables or disables Automatic Status Back (ASB). ASB is enabled when 
n is a value other than 0. After you enable ASB, the printer transmits its status at the 
specified interval until ASB is disabled. ASB is disabled when n = 0, at which point the 
printer stops transmitting its status.

ASB is the function that transmits the printer status (such as printer cover open/closed 
and online/offline) continuously at the specified time interval, even if the printer status 
did not change. Using this function, the host can check if the printer is running 
properly.

For the parallel and USB interfaces, printer status is transmitted whenever the host 
computer changes to the reverse mode, regardless of whether the printer changed 
status. You should set the time interval at which the host changes to reverse mode to 
more than 500 ms so that you receive the correct status. For the serial interface, 
status is transmitted continuously at the interval of 1 sec even if the status is not 
changed.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

The 4 bytes of printer information transmitted are in the following format:

ASCII GS a n
Hex 1D 61 n
Decimal 29 97 n

Byte 1—Printer Information

Bit Off/On Hex Decimal Function

0 Off 00 0 Not used. Fixed to Off

1 Off 00 0 Not used. Fixed to Off

2 Off 00 0 Not used. Fixed to Off

3 Off 00 0 On-line

On 08 8 Off-line

4 On 10 16 Not used. Fixed to On

5 Off 00 0 Cover is closed

On 20 32 Cover is open
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6 Off 00 0 Paper is not being fed by the paper feed button

On 40 64 Paper is being fed by the paper feed button

7 Off 00 0 Not used. Fixed to Off

Byte 2—Printer Information

Bit Off/On Hex Decimal Function

0 Off 00 0 Not used. Fixed to Off

1 Off 00 0 Not used. Fixed to Off

2 Off 00 0 Not used. Fixed to Off

3 Off 00 0 Not used. Fixed to Off

4 Off 00 0 Not used. Fixed to Off

5 Off 00 0 No unrecoverable error

On 20 32 Unrecoverable error 

(Turn off the power as soon as possible if this occurs.)

6 Off 00 0 No automatically recoverable error

On 40 64 Automatically recoverable error occurred

7 Off 00 0 Not used. Fixed to Off

Byte 3—Paper Sensor Information

Bit Off/On Hex Decimal Function

0,1 Off 00 0 Not used. Fixed to Off

2,3 Off 00 0 Paper end sensor: paper present

On 0C 12 Paper end sensor: no paper present

4 Off 00 0 Not used. Fixed to Off

5 Off 00 0 Not used. Fixed to Off

6 Off 00 0 Not used. Fixed to Off

7 Off 00 0 Not used. Fixed to Off

Byte 4—Paper Sensor Information

Bit Off/On Hex Decimal Function

0 On 01 1 Not used. Fixed to On

1 On 02 2 Not used. Fixed to On

2 On 04 4 Not used. Fixed to On

3 On 08 8 Not used. Fixed to On

4 Off 00 0 Not used. Fixed to Off

5 Off 00 0 Not used. Fixed to Off

6 Off 00 0 Not used. Fixed to Off

7 Off 00 0 Not used. Fixed to Off
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GS f

Description  Select font for HRI characters

Syntax  GSfn

Range  n = 0, 1, 48, 49

Default  n = 0

Notes  This command selects a font for the HRI (Human Readable Interpretation) 
characters used when printing a barcode, using n as follows:

Use GS H on page 117 to specify the print position of HRI characters.

Differences  Configuration of font: Font A (12 × 24), Font B (9 × 24)

GS h

Description  Specify Barcode Height

Syntax  GShn

Range  n = 1 to 255

Default  n = 162

Notes  GS h specifies the height of the barcode to n dots.

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS f n
Hex 1D 66 n

Decimal 29 102 n

n Font

0, 48 Font A

1, 49 Font B

ASCII GS h n
Hex 1D 68 n
Decimal 29 104 n
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GS k

Description  Print Barcode

Syntax  

1  GSkm d1...dkNUL

2  GSkmn d1...dn

Range  

The range of the variables depend on the barcode system.

1  • m = 0 to 6

• k = the number of bytes of barcode data.

• d = the character code data of the barcode data to be printed. 

2  • m = 65 to 73

• n = the number of bytes of barcode data.

• d = the character code data of the barcode data to be printed. 

1  ASCII GS k m d1...dk NUL
Hex 1D 6B m d1...dk NUL

Decimal 29 107 m d1...dk NUL
2  ASCII GS k m n d1...dn

Hex 1D 6B m n d1...dn
Decimal 29 107 m n d1...dn

1  

m Barcode System Range of k Range of d

0 UPC-A k = 11, 12 d = 48 to 57

1 UPC-E k = 11, 12 d = 48 to 57

2 JAN13(EAN) k = 12, 13 d = 48 to 57

3 JAN8(EAN) k = 7, 8 d = 48 to 57

4 CODE39 1 ? k d = 48 to 57, 65 to 90

d = 32, 36, 37, 43, 45, 46, 47

5 ITF 1 ? k (even number) d = 48 to 57

6 CODABAR 1 ? k d = 48 to 57, 65 to 68

d = 36, 43, 45, 46, 47, 58
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Default  None

Notes  This command selects a barcode system and prints the barcode.

The printer ignores any setting that exceeds the print area set by ESC W on page 58. 
Print modes (such as emphasized or double-strike) do not affect the printing of a 
symbol. Exceptions are the character size and upside-down printing.

A quiet zone (the spaces surrounding the symbol such as upper, lower, left, and right 
spaces) should be taken into account when using this command.

2  

m Barcode System Range of k Range of d

65 UPC-A 11 to 12 d = 48 to 57

66 UPC-E 11 to 12 d = 48 to 57

67 JAN13(EAN) 12 to 13 d = 48 to 57

68 JAN8(EAN) 7 to 8 d = 48 to 57

69 CODE39 1 to 255 d = 48 to 57, 65 to 90

d = 32, 36, 37, 43, 45, 46, 47

70 ITF 1 to 255 (even number) d = 48 to 57

71 CODABAR 1 to 255 d = 48 to 57, 65 to 68

d = 36, 43, 45, 46, 47, 58

72 CODE93 1 to 255 d = 0 to 127

73 CODE128 2 to 255 d = 0 to 127
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GS r

Description  Transmit Status

Syntax  GSrn

Range  n = 1, 49

Default  None

Notes  The command transmits the one-byte status specified by n as follows:

The status to be transmitted is as follows:

• Paper sensor status (n = 1, 49):

Bits 2 and 3: This command can not be executed when the printer is offline due to the 
lack of paper. Therefore, the status of bit 2 (1) and bit 3 (1) is not transmitted.

ASCII GS r n
Hex 1D 72 n
Decimal 29 114 n

n Function

1, 49 Transmit the paper sensor status

Bit Off/On Hex Decimal Function

0, 1 Off 00 0 Paper near-end sensor: Paper adequate

On 03 3 Paper near-end sensor: Paper near end

2, 3 Off 00 0 Paper end sensor: Paper present

On 0C 12 Paper end sensor: Paper not present

4 Off 00 0 Fixed

5 Off 00 0 Reserved

6 Off 00 0 Reserved

7 Off 00 0 Fixed
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GS v 0

Description  Print Raster Bit Image

Syntax  GSv0mxLxHyLyHd1...dk

Range  m = 0 to 3, 48 to 51
1 ? (xL + xH × 256) ? 384 (xL = 0 to 80, xH = 0, 1)
1 ? (yL + yH × 256) ? 1662 (yL = 0 to 126, yH = 0 to 6)
d = 0 to 255 = the definition data of the bit image data.
k = 1 to 119664

• xL, xH = (xL + xH × 256) byte(s) in the horizontal direction for the bit image

• yL, yH = (yL + yH × 256) dot(s) in the vertical direction for the bit image

Default  None

Notes  This command prints a raster bit image according to the mode defined by m.

In Standard mode, this command is effective when the print buffer is empty and the 
printer is at the beginning of the line. If the print buffer is not empty, after processing m, 
the printer treats the following data as normal data.

In Page mode, the bit image is stored in the print buffer without being printed.

None of the available print modes (such as emphasized, underlined, or double-strike) 
affects the printing of the bit image.

The default dot density set by GS L on page 120 is applied to printing of the bit image.

ASCII GS v 0 m xLxHyLyHd1...dk
Hex 1D 76 30 m xLxHyLyHd1...dk
Decimal 29 118 48 m xLxHyLyHd1...dk

m Mode Vertical dot density (DPI) Horizontal dot density (DPI)

0, 48 Normal 203 203

1, 49 Double-width 203 203/2

2, 50 Double-height 203/2 203

3, 51 Quadruple 203/2 203/2

m Mode Vertical dot density (DPI)
Horizontal dot density 
(DPI)

0, 48 Normal 203 203

1, 49 Double-width 203 203/2

2, 50 Double-height 203/2 203

3, 51 Quadruple 203/2 203/2
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GS w

Description  Set Barcode Width

Syntax  GSwn

Range  n = 2 to 6 = the barcode module width

Default  n = 3

Notes  GS w sets the horizontal width of a barcode, using n as follows:

This command is effective for the following barcodes:

• Multi-level barcodes: UPC-A, UPC-E, JAN13, HAN8, CODE93, CODE128

• Binary-level barcodes: CODE39, ITF, CODABAR

This command remains in effect until one of the following occurs: ESC @ on page 50 
is run, the printer defaults are reset, or the printer is power cycled.

ASCII GS w n
Hex 1D 77 n
Decimal 29 119 n

n
Multi-level barcode 
module width (mm)

Binary-level barcode

Thin element width (mm) Thick element width (mm)

2 0.250 0.250 0.625

3 0.375 0.375 1.000

4 0.500 0.500 1.250

5 0.625 0.625 1.625

6 0.750 0.750 2.000
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BS L A

Description  Execute Automatic Calibration in Label Mode

Syntax  BSLA

Notes  BS L A, which is effective only in Label mode, executes auto calibration.

When this command is executed, this printer feeds three labels or three black marks 
to read the light intensity reflected from the liner or black mark. It stores the optimal 
value for reading the labels or black marks into nonvolatile memory. The printer 
moves the print position to the leading edge of the next label or black mark using this 
value.

BS L L

Description  Select Label Mode

Syntax  BSLL

Notes  BS L L specifies Label mode, which must be used for the printer to print on 
labels or black mark paper.

This command can activate Label mode even if Receipt mode is predefined by the 
memory switch (Msw 8-5). However, because the memory switch (Msw 8-5) is set to 
enable the default mode, Receipt mode goes into effect after the printer defaults are 
reset or the printer is power cycled. The memory switch (Msw 8-5) should be enabled 
to maintain Label mode after the printer defaults are reset or the printer is power 
cycled.

After the printer has entered Label mode, do the following to ensure proper operation:

• Run automatic calibration (BS L A on page 133) to allow the printer to determine 
the label or black mark specifications.

• Readjust the print position by pressing the Feed button or opening and then 
closing the printer cover.

ASCII BS L A
Hex 08 4C 41
Decimal 8 76 65

ASCII BS L L
Hex 08 4C 4C
Decimal 8 76 76
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BS L R

Description  Select Receipt Mode

Syntax  

Notes  This command selects Receipt mode, which must be set for printing on 
continuous roll paper. This command is enabled only in Label mode.

This command can activate Receipt mode even if Label mode is predefined by the 
memory switch (Msw 8-5). However, because the memory switch (Msw 8-5) is set to 
enable the default mode, Label mode goes into effect after the printer defaults are 
reset or the printer is power cycled. The memory switch (Msw 8-5) should be set to 
disable Receipt mode after the printer defaults are reset or the printer is power cycled.

BS M

Description  Specify Font Type

Syntax  BSMnm

Range  m = 65 to 67
n = 0

Default  n = 0

Notes  BS M specifies the font type by m as follows:

This command remains in effect until one of the following occurs: ESC ! on page 45, 
ESC @ on page 50, or ESC M on page 54 is run; the printer defaults are reset; or the 
printer is power cycled.

ASCII BS L R
Hex 08 4C 52
Decimal 8 76 82

ASCII BS M n m
Hex 08 4D n m
Decimal 08 77 n m

m Function (Select font type)

65 Font A (12 × 24)

66 Font B (9 × 17)

67 Font C (9 × 24)
P1067298-003 Virtual Device-E User Guide 08/28/2018



135Commands
Set/Get/Do (SGD) Commands
Set/Get/Do (SGD) Commands

The following SGD commands were added for use with your Virtual Device app. For 
more detailed information on SGD commands, see the Programming Guide for 
ZPL II®, ZBI 2, Set/Get/Do, Mirror, and WML (formerly the ZPL II Programming 
Guide).

apl.enable

Description  This command enables or disables a Virtual Device app.

Type  setvar

apl.version

Description  This command returns the version of the currently running Virtual 
Device app.

Type  getvar

Note • 

• ZPL and CPCL may not function normally when a Virtual Device app is enabled. 
• You must restart the printer after changing the value of apl.enable.

Commands Details

setvar This command instructs the printer to enable a virtual device. 

Format: ! U1 setvar "apl.enable" "value" 
Values: 

"apl-e" = enable Virtual Device-E
"none" = disable any Virtual Device app (ZPL and CPCL function normally)

Example 1 • This example shows how to enable the Virtual Device-E app:

! U1 setvar "apl.enable" "apl-e"

Example 2 • This example shows how to disable the Virtual Device-E app:

! U1 setvar "apl.enable" "none"

Commands Details

getvar Format: ! U1 getvar "apl.version" 
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apl.framework_version

Description  This command returns the level of support for Virtual Devices in the 
printer operating system.

Type  getvar

Commands Details

getvar Format: ! U1 getvar "apl.framework_version" 
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Supported Fonts
This section provides you with available fonts on the Zebra printers with Virtual 
Device-E.
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Supported Fonts

Table 1 shows the standard fonts and associated character sets that are provided with 
Virtual Device-E.

a

Table 1 • Supported Fonts

Font Name Character Set

Code Page 
437

Code Page 
850
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Code Page 
1251

Code Page 
1252

Table 1 • Supported Fonts (Continued)

Font Name Character Set
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ZDownloader Utility
This section provides you with the instructions for downloading and installing the 
ZDownloader Utility.
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Downloading the ZDownloader Utility

To download the ZDownloader Utility, perform the following from your 
computer:

1. Open a web browser and navigate to http://www.zebra.com.

2. Click on the Support & Downloads header on the web page.

3. Select a printer.

4. When the printer page opens, locate and select the Software Utilities tab.

5. Scroll down to the ZDownloader Utility and select the Download link. 

6. Click on the Accept and Begin Download Now button. 

The installation file download will begin.

Note • You will be prompted to create a user profile or login to 
http://www.zebra.com with an existing profile to download the ZDownloader Utility.
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Installing the ZDownloader Utility
To install the ZDownloader Utility, perform the following from your computer:

1. Run the installation file after the download is complete.

2. If you are prompted to allow the application to make changes to your computer, 
click Yes.

The utility installs on your computer. When installation is complete, the Firmware 
Downloader and ZBI Key Manager installation wizard appears.

3. Click Next.

The End User License Agreement appears.
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4. Read the terms of the agreement.

5. Click the checkbox to accept the terms.

6. Click Next.

The installation wizard displays information about the installation.
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7. Click Next.

The installation wizard installs the application.

8. Click Finish to close the wizard.
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Index
A
absolute print position, 46
absolute vertical print position, 67
alignment, 60
application installation

acquiring the app, 12
canceling a download in progress, 23
downloading the app to printers, 21

auto-detect printers, 14
automatic calibration, 133

B
barcodes

print, 128
set width, 132
specify height, 127

battery status, 119
bit images

bit image mode, 48
defining nonvolatile bit images, 64
printing nonvolatile bit images, 63

black mark
adjust paper position, 69
set control functions, 69
set paper format, 70

C
calibration, 133
cancel print data, 44
character code table selection, 61
character definition, 47

character font selection, 46, 54
character right space, 45
character set enable/disable, 47
character size specification, 66
Code Page 1251 samples, 139
Code Page 1252 samples, 139
Code Page 437 samples, 138
Code Page 850 samples, 138
code page selection, 61
columns for PDF417, 74
connectivity options, 9

D
Data Matrix

encode and print symbol data, 96
set code size, 94
symbol data, 74

disabling the Virtual Device
by apl.enable SGD command, 135
through the control panel

QLn320 and QLn220 printers, 29
QLn420 printers, 26
Supported ZTxxx And ZDxxx Printers

With A Display, 32
ways to enable/disable, 25

double-height mode, 46
double-strike mode, 52
double-width mode, 46

E
emphasized mode, 46, 51
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enabling the Virtual Device
by apl.enable SGD command, 135
through the control panel

QLn320 and QLn220 printers, 29
QLn420 printers, 26
Supported ZTxxx And ZDxxx Printers

With A Display, 32
ways to enable/disable, 25

error correction level
PDF417, 77
QR Code, 85

F
features, 8
font

select font type, 134
fonts

1-byte character font selection, 54
character sets, 138

form feed, 44

G
graphics

See also nonvolatile bit images
data processing, 108
define raster graphics data, 113
print graphics data, 109
store raster graphics data, 115

H
hex dump mode, 68
horizontal tab

move print position to next tab, 43
set position, 51

Human Readable Interpretation (HRI) 
characters

select font, 127
select print position, 117

I
Initialize Printer, 50
international character set, 55
IP Ethernet printers

auto-detect, 14
manually add, 15

K
key code list for nonvolatile graphics, 111

L
Label mode selection, 133
left margin, 120
liability, 2
line feed, 43
line spacing

select default, 49
setting, 50

M
macro

execute, 124
start/end definition, 116

manually add printers, 15
margins, 120
MaxiCode

encode and print symbol data, 92
set mode, 90
store symbol data, 91
symbol data, 73

memory switch value
change, 100
transmit, 103

modifying printer communication settings 
through ZDownloader, 19

module height for PDF417, 76
module width for PDF417, 76

N
nonvolatile bit images

See also graphics
defining, 64
delete all, 111
delete kc1 and kc2, 112
print kc1 and kc2, 114
printing, 63
transmit key code list, 111
transmit memory capacity, 108

nonvolatile graphics key code list, 111
nonvolatile user memory

formats, 97
transmit amount unused, 110

number of columns for PDF417, 74
number of rows for PDF417, 75

P
Page mode selection, 53
parallel printers, 15
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PDF417
encode and print symbol data, 80
encode and send size information, 82
select standard or simplified option, 78
specify error correction level, 77
specify height of module, 76
specify number of columns, 74
specify number of rows, 75
specify width of module, 76
store symbol data, 79
symbol data, 72

position alignment, 60
print area specification, 58
print buffer clearing, 44
print command

encode and print QR Code symbol data, 87
print and feed a number of lines, 60
print and feed paper, 52
print and line feed, 43
print barcodes, 128
print data, 44
print nonvolatile bit images, 63
raster bit image, 131

print direction selection, 57
print mode specification, 45
print PDF417 symbol data, 80
print position

absolute, 46
absolute vertical, 67
relative, 59
set to beginning of line, 121

print servers, 9
printer ID transmission, 118
printer status transmission, 41

Q
QR Code

encode and print symbol data, 87
save symbol data, 86
set error correction level, 85
set QR Code module size, 84
set the QR Code model, 83
symbol data, 73
transmit symbol data size information, 89

R
raster graphics

define data in nonvolatile graphics area, 113
print, 131
store data, 115

Receipt mode selection, 134
relative print position, 59
reverse printing mode, 116
rows in PDF417, 75

S
serial interface

add printers, 15
configuration, 104
transmit communication conditions, 106

Set/Get/Do (SGD) commands, 135
simplified PDF417, 78
size information for PDF417, 82
Standard mode selection, 56
standard PDF417, 78
status

paper sensor, 130
printer, 41

symbols, specifying and printing, 71

T
test print, 68
transmit memory switch value, 103
transmit serial interface conditions, 106
transmit status, 41

U
underline mode, 46, 49
upside-down printing, 62
USB printers, 14
User Setting mode

end, 99
start, 98

user-defined character definition, 47

V
version

level of support for Virtual Devices, 136
of Virtual Device, 135

vertical print position (absolute), 67
Virtual Device version, 135

W
wired print server

auto detect, 14
for more information, 9
manually add, 15
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wireless print server
auto detect, 14
for more information, 9
manually add, 15

Z
ZDownloader

adding printers, 13
canceling a download in progress, 23
deleting printers, 20
downloading the Virtual Device app to printers, 

21
downloading ZDownloader, 141
installing ZDownloader, 142
modifying printer settings, 19

zebra printer setup utility for android devices, 13
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